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계산기 사용 전에

먼저 읽으십시오

본 사용설명서에 하여
• 어떤 경우라도 CASIO Computer Co., Ltd.는 본 제품 및 부속된 항목의 구
입 또는 사용에 관련되거나 그것으로 유발되는 특수하거나, 부수적이거
나, 우발적이거나 결과적인 손해에 해서 일체의 책임을 지지 않습니다.
또한, CASIO Computer Co., Ltd.는 본 제품 및 부속된 항목의 사용으로
제3자에게 발생하는 어떤 종류의 청구에 해서도 책임을 지지 않습니다.

• 본 사용설명서의 내용은 예고 없이 변경될 수 있습니다.
• 본 사용설명서에서 설명하는 표시와 조명(키 표시와 같은 것)은 설명을
위한 것이며, 실제 표시되는 항목과 다를 수 있습니다.

• QR Code 는 일본 및 기타 국가에서 DENSO WAVE INCORPORATED의
등록 상표입니다.

• 본 사용설명서에 사용되는 회사명 및 제품명은 각 소유자의 등록상표 또
는 상표일 수 있습니다.

키 조작
아래의 예는 본 사용설명서에서 키 조작이 어떻게 표현되는지 보여줍니다.

예 1: 
키는 위에 표시된 순서 로 눌러야 합니다(왼쪽에서 오른쪽으로).

예 2: (π)*
상기는  키를 누른 후  키를 눌러야 π 기호가 입력됨을 나타냅니다. 모
든 다중 키 입력 조작은 다음과 같이 표시됩니다. 키 캡 표시가 표시되고 입
력 문자 또는 괄호 안의 명령이 표시됩니다.

* 이 예에서 사용된 키 기호에 한 추가 정보는 “키 표시” (13페이지)를 참
조하십시오.
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예 3: , , , , , 

• (1)이 가리키는 개별 커서 키는 , , , 로 표시됩니다.
• (2)가 가리키는 개별 페이지 스크롤 키는 , 로 표시됩니다.

메뉴 조작
본 사용설명서의 일부 조작은 아래 예와 같이 단순화된 메뉴 형태의 조작을
사용합니다.

예 1

 – [Other] > [π]

또는

 키를 누른 후 [Other] > [π]를 선택합니다.

실제 조작 1

1.  키를 누릅니다.
2.  및  키를 사용하여 [Other]를 선택한 후  키를 누릅니다.
3.  및  키를 사용하여 [π]를 선택한 후  키를 누릅니다.

예 2

 - Calculate

또는

 키를 누르고 Calculate 앱 아이콘을 선택한 후  키를 누릅니다.
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실제 조작 2

1.  키를 누릅니다.
2. 커서 키( , , , )를 사용하여 Calculate 앱 아이콘을 선택한 후

 키를 누릅니다.

 키 및  키
 키 및  키는 동일한 조작을 수행합니다. 본 사용설명서에서  키는

설정을 선택하거나 적용하는 데 사용되고  키는 계산을 실행하는 데 사용
됩니다. 그러나  또는  중 하나가 표시된 조작에 해  또는  키를
눌러도 차이가 없습니다.

예

특정 계산기 앱을 사용하거나 예 조작에 해 특정 설정을 구성하라는 지시
가 없는 경우 아래의 앱 및 설정을 가정합니다.
계산기 앱: Calculate
설정: 초기 계산기 설정

계산기를 초기 설정으로 되돌리는 방법에 한 정보는 “계산기 초기화하
기” (7페이지)를 참조하십시오.

계산기 초기화하기

중요!

• 아래 절차는 Contrast 및 Auto Power Off를 제외한 모든 계산기 설정을 초기화합니다.
또한 계산기 메모리에 저장된 모든 데이터도 삭제합니다.

1.  키를 눌러서 HOME 화면을 표시합니다.
2. 커서 키( , , , )를 사용하여 계산기 앱 아이콘을 선택한 후  키
를 누릅니다.

3.  키를 누른 다음 [Reset] > [Initialize All]> [Yes]를 선택합니다.
• 그러면 HOME 화면이 표시됩니다.

계산기 “Get Started” 화면
HOME 화면이 표시되는 동안  키를 누르면 아래 정보를 포함한 “Get
Started” 화면이 표시됩니다.
• 월드와이드 교육 서비스(https://wes.casio.com/calc/cw/)의 “Get

Started” 웹페이지에 액세스하기 위한 QR Code
Get Started 웹페이지에서 사용설명서 및 기타 관련된 정보에 액세스하면
계산기 사용을 시작하는 데에 도움이 됩니다.

• 계산기 ID 번호(24 문자열)

7

https://wes.casio.com/calc/cw/


 키를 눌러서 HOME 화면으로 되돌아갑니다.

주의

• SETTINGS 메뉴에서 선택하여 Get Started 화면을 표시할 수도 있습니다. “SETTINGS
메뉴 사용하기” (19페이지)를 참조하십시오.

주의 사항

안전상의 주의사항
CASIO 제품을 구입해 주셔서 감사합니다.
본 제품을 사용하기 전에 반드시 “안전상의 주의사항”을 읽고 올바르게 사
용하시기 바랍니다. 만약을 비하여 사용설명서 등은 소중히 보관해 주십
시오.

위험
사망 또는 중상을 입을 수 있는 중 한 위험을 초래할 수 있는 것을
나타냅니다.

 버튼 타입 및 코인 타입 전지에 한 주의사항(fx-991CW에만
해당)

우발적으로 전지를 삼키지 않도록 주의하십시오.
전지는 어린이의 손이 닿지 않도록 각별한 주의가 필요합니다.

우발적으로 전지를 삼켰거나 전지를 삼켰을 가능성이 있는 경우에는 즉
시 의사에게 연락해 주십시오.
전지를 삼키면 화학적 화상, 점막 조직 침투 및 기타 심각한 문제를 유발
해서 사망할 우려가 있습니다.

경고
사망 또는 중상을 입을 수 있는 위험을 초래할 수 있는 것을 나타냅
니다.
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 표시 화면

LCD를 누르거나 강한 충격을 가하지 마십시오.

그렇게 하면 LCD 유리가 깨져서 부상을 입을 위험이 있습니다.

LCD에 금이 간 경우 내부의 액체를 만지지 마십시오.

LCD 액이 피부에 닿으면 피부 자극의 위험이 있습니다.
LCD 액이 입에 들어간 경우 즉시 입을 헹구고 의사에게 연락하십시오.
LCD 액이 눈이나 피부에 닿은 경우 깨끗한 물로 헹구고 의사에게 연락하
십시오.

 전지에 한 주의사항

누출된 전지액이 피부 또는 의복에 묻은 경우에는 깨끗한 물로 즉
시 세척해 주십시오.

전지액이 눈에 들어가면 시력이 상실될 가능성이 있습니다. 눈을 세척한
후 즉시 의사에게 연락해 주십시오.

주의
경미한 부상이나 물리적 손상의 위험을 초래할 수 있는 것을 나타
냅니다.

아래의 주의사항을 준수해 주십시오. 그렇게 하지 않으면 전지가 파열되
어 화재, 부상의 위험을 초래할 수 있으며, 액체 누출로 인해 주변 물체가
더러워질 수 있습니다.

• 전지를 분해하거나 전지가 합선되지 않도록 하십시오.
• 비충전식 전지를 충전하지 마십시오.
• 전지를 열에 노출시키거나 불 속에 던지지 마십시오.

• 지정된 종류의 전지만 사용하십시오.
• 전지의 전극(플러스(+) 및 마이너스(-))이 올바르게 향하도록 하
여 전지를 넣습니다.

• 전지가 방전된 후 가능한 한 빨리 전지를 교체하십시오.
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 전지에 한 주의사항

아래의 주의사항을 준수해 주십시오. 준수하지 않으면 전지가 폭
발하거나 가연성 액체나 기체가 누출되는 원인이 될 수 있습니다.

• 본 제품용으로 지정된 전지 타입만을 사용하십시오.
• 전지를 태우거나 소각로에 폐기하거나, 기계적으로 파쇄하거나 절단하
지 마십시오.

• 사용, 보관 또는 이동 중에 극도로 높거나 낮은 온도에 전지가 노출되
지 않도록 하십시오.

• 사용, 보관 또는 이동 중에 극도로 낮은 기압에 전지가 노출되지 않도
록 하십시오.

취급상 주의사항
• fx-570CW: 계산기가 정상적으로 작동하더라도 적어도 2년에 한 번은 전
지를 교체하십시오(R03).
fx-991CW: 계산기가 정상적으로 작동하더라도 적어도 2년에 한 번은 전
지를 교체하십시오(LR44).
소모된 전지는 전지액이 누설되어 계산기에 손상을 주거나 동작 불량의
원인이 됩니다. 절 로 계산기에 소모된 전지를 넣은 채로 방치하지 마십
시오. 전지가 완전히 소모된 때에는 계산기를 사용하려 하지 마십시오
(fx-991CW).

• 보증이 적용되지 않는 전지 누액으로 인한 오작동 또는 손상에 해서는
비용이 청구됩니다.

• 계산기에 부속된 전지는 선적 및 보관 중에 조금씩 소모됩니다. 그 때문에
소정의 전지 수명에 못 미치어 전지를 교체해야 할 경우도 있습니다.

• 극단적인 온도 조건이나 습기나 먼지가 많은 장소에서의 계산기의 사용
및 보관은 피해 주십시오.

• 계산기에 과도한 충격을 주거나 압력을 가하거나, 또는 구부리지 마십시
오.

• 절 로 계산기를 분해하려 하지 마십시오.
• 계산기의 외부를 청소할 때에는 부드럽고 마른 천을 사용해 주십시오.
• 계산기 또는 전지를 폐기할 때에는 거주하는 특정 지역의 법률 및 규정에
따라 주십시오.

시작하기

전면 커버 부착 및 제거

전면 커버 제거하기

계산기를 사용하기 전에 전면 커버(①)를 제거하여 뒷면(②)에 부착하십시
오.
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전면 커버 부착하기

계산기를 사용하지 않을 때는 전면 커버(①)를 제거하여 전면(②)에 부착하
십시오.
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중요!

• 계산기를 사용하지 않을 때는 항상 전면 커버를 계산기에 부착하십시오. 그렇지 않으면
실수로  키를 조작하면 전원이 켜지고 전지가 소모될 수 있습니다.

전원 켜기 및 끄기
 키를 눌러서 계산기의 전원을 켭니다.

(OFF) 키를 눌러서 계산기의 전원을 끕니다.

주의

• 전원을 켜려면  키를 길게 누릅니다. 실수로 전원이 켜지는 것을 방지하기 위해 
키의 상단이 다른 키보다 약간 낮습니다.

• 전원을 켠 직후 아래와 같은 화면이 나타나면 전지 잔량이 부족한 것입니다.

이 화면이 나타나면 가능한 한 빨리 전지를 교체하십시오. 전지 교체에 한 자세한 내
용은 “전지 교체” (136페이지)를 참조하십시오.

• 약 10분 또는 60분 동안 사용하지 않으면 계산기가 자동으로 꺼집니다.  키를 눌러
서 계산기의 전원을 다시 켜 주십시오.
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HOME 화면
 키를 누르면 HOME 화면이 표시됩니다. HOME 화면에는 설치된 계산기

앱 목록이 표시됩니다.

  HOME 화면   Calculate 앱 화면
                 

설치된 계산기 앱에 한 정보는 “설치된 계산기 앱 목록” (17페이지)을
참조하십시오.

표시 콘트라스트 조정하기
1.  키를 누르고 계산기 앱 아이콘을 선택한 후  키를 누릅니다.
2.  키를 누른 후 [System Settings] > [Contrast]를 선택합니다.

3.  및  키를 사용하여 콘트라스트를 조정합니다.
4. 원하는 로 설정된 후에  키를 누릅니다.

중요!

• 표시 콘트라스트를 조정해도 표시의 판독이 향상되지 않는 경우에는 전지 용량이 낮은
것일 수도 있습니다. 전지를 교체해 주십시오.

키 표시
 키를 누른 후 두 번째 키를 누르면 두 번째 키의 체 기능을 실행합니

다. 체 기능은 좌측에서 키 위에 인쇄된 텍스트로 표시됩니다.

(1) 키캡 기능: 
(2) 체 기능: (π)
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인디케이터

인디케이터

아래 표는 화면 상단에 나타나는 인디케이터에 해 설명합니다.

인디케이터: 의미:

 키를 눌러서 키패드가 시프트되었습니다. 키를
누르면 키패드가 시프트되지 않으며 본 인디케이
터가 나타나지 않습니다.

SETTINGS 메뉴의 Input/Output에 해 MathI/
MathO 또는 MathI/DecimalO가 선택되었습니다.

 /  / 
SETTINGS 메뉴에서 현재의 Angle Unit( :
Degree, : Radian, 또는 : Gradian) 설정.

FIX 고정된 소수 자리수가 적용됩니다.

SCI 유효자릿수가 설정되어 있습니다.

E
SETTINGS 메뉴의 Engineer Symbol에 On이 선
택되었습니다.

i/∠
SETTINGS 메뉴에서 현재의 Complex Result(i:
a+bi 또는 ∠: r∠θ) 설정.

 / 

현재 표시된 계산 결과에 해 이전( ) 또는 다음
( ) 계산 이력이 있습니다. 일부 계산기 앱에서 이
러한 인디케이터는 사용 가능한 다른 계산 결과가
있음을 나타냅니다.

계산기는 전적으로 또는 전지와 일부 조합으로 태
양 전지에 의해 직접 전원이 공급됩니다.
(fx-991CW만 해당)
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메뉴 사용하기
계산기의 많은 조작은 메뉴 화면을 사용하여 수행됩니다. 아래 예는  키
를 눌렀을 때 나타나는 메뉴 화면에서 시작하는 조작을 보여줍니다.

메뉴 항목 선택하기

메뉴 항목을 선택하려면 커서 키( , , , )를 사용하여 강조 표시한
다음  키를 누릅니다.  및  키는 메뉴 항목 열이 여러 개인 경우에만
사용됩니다.

메뉴 계층 간 탐색

메뉴 항목의 오른쪽에 있는 “ ” 표시는 해당 항목 아래에 더 낮은 계층 레벨
이 있음을 의미합니다. 메뉴 항목을 선택하고  또는  키를 누르면 계층
의 다음 하위 레벨을 탐색합니다. 계층의 다음 상위 레벨로 돌아가려면 
키를 누릅니다.

주의

• 1열 메뉴의 계층에서 하위 레벨에 있는 경우  외에  키를 눌러 다음 상위 레벨로
돌아갈 수 있습니다.

라디오 버튼( / )으로 메뉴 항목 선택하기

디스플레이에 여러 옵션 목록이 표시되면 각 옵션의 왼쪽에 라디오 버튼(
또는 )이 표시됩니다. 는 현재 선택된 옵션을 나타냅니다.

라디오 버튼 메뉴 항목 설정 구성하기
1. 해당 메뉴 항목을 강조 표시한 다음  키를 누릅니다.
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• 다음에 일어나는 일은 선택한 메뉴 항목의 종류에 따라 다릅니다.
- 선택한 메뉴 항목에 해 더 이상 구성할 설정이 없으면 옆에 있는 라
디오 버튼이 로 변경됩니다.

- 선택한 메뉴 항목에 구성할 설정이 더 많으면 메뉴 항목 설정을 선택
하는 화면이 나타납니다. 이 경우 2단계로 진행합니다.

2. 설정 화면에서 원하는 설정을 강조 표시한 후  키를 누릅니다.
• 이전에 선택한 메뉴 항목 옆의 라디오 버튼이 로 변경된 상태에서 1
단계의 메뉴 항목 화면으로 돌아갑니다.

화면 간 스크롤하기

메뉴 항목이 너무 많아 한 화면에 표시되지 않는 경우 디스플레이 오른쪽에
스크롤 막 가 나타납니다.
•  및  키를 사용해서 화면 간을 스크롤합니다.
•  및  키를 사용하여 한 줄씩 스크롤합니다.

메뉴를 닫고 메뉴 이전에 표시된 화면으로 돌아가기

 키를 누릅니다.

주의

•  키를 누름으로써 , , , , , 또는  키를 눌러서 표시된 메뉴를 닫을
수 있습니다. 표시된 메뉴가 특정 계산기 앱을 실행한 직후 나타나는 메뉴이거나 특정
앱 메뉴인 경우  키를 눌러 닫을 수 없습니다. 이 경우  키를 눌러야 메뉴를 닫을
수 있습니다.
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계산기 앱 및 메뉴

계산기 앱

계산기 앱 선택
수행하려는 계산 종류에 적합한 계산기 앱을 선택합니다.
1.  키를 눌러서 HOME 화면을 표시합니다.

• 각 계산기 앱에 한 정보는 “설치된 계산기 앱 목록” (17페이지)을
참조하십시오.

2. 커서 키( , , , )를 사용하여 원하는 계산기 앱 아이콘을 선택합
니다.

3.  키를 눌러서 여러분이 아이콘을 선택한 계산기 앱의 초기 화면을 표
시합니다.

설치된 계산기 앱 목록

아이콘 설명

(Calculate)

일반 계산

(Statistics)

통계 및 희귀 계산

(Distribution)

분포 계산
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(Spreadsheet)

스프레드시트 계산

(Table)

하나 또는 두 개의 함수를 기반으로
수치표를 생성

(Equation)

연립방정식, 고차방정식, Solver(입
력된 방정식에 포함된 모든 변수의
값을 찾는 함수)

(Inequality)

부등식 계산

(Complex)

복소수 계산

(Base-N)

특정한 숫자 체계(2진수, 8진수, 10진
수, 16진수)를 포함하는 계산

(Matrix)

행렬 계산

(Vector)

벡터 계산
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(Ratio)

비율 계산

(Math Box)

수학 학습을 지원하는 다음 기능.
Dice Roll, Coin Toss: 확률 시뮬레이
션

SETTINGS 메뉴 사용하기
SETTINGS 메뉴를 표시하려면 계산기 앱 사용 중에  키를 누릅니다.
SETTINGS 메뉴에는 아래 메뉴 항목이 포함됩니다.

Calc Settings
계산 결과의 표시 형식과 같은 계산 설정을 구성하
기 위한 메뉴 항목이 포함되어 있습니다.

System Settings
콘트라스트 조정과 같은 계산기 작동 설정을 구성
하기 위한 메뉴 항목이 포함되어 있습니다.

Reset
다양한 종류의 리셋 작업을 수행하기 위한 메뉴 항
목이 포함되어 있습니다.

Get Started
Get Started 화면을 표시합니다. 추가 정보는 “계
산기 “Get Started” 화면” (7페이지)을 참조하십
시오.

주의

• HOME 화면이 표시된 상태에서  키를 누르면 SETTINGS 메뉴 신 Get Started 화
면이 표시됩니다.

• 계산기 앱에 표시되는 화면에 따라  키를 눌러도 SETTINGS 메뉴가 표시되지 않을
수 있습니다.

계산기 설정 변경하기
1.  키를 누르고 계산기 앱 아이콘을 선택한 후  키를 누릅니다.
2. SETTINGS 메뉴를 표시하려면  키를 누릅니다.
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3.  및  키를 사용하여 Calc Settings 또는 System Settings를 선택한
다음  키를 누릅니다.
• 그러면 선택한 메뉴에 포함된 설정 항목의 목록을 표시합니다.
여기 화면은 [Calc Settings]를 선택했을 때 나타나는 예를 보여줍니다.

• [Calc Settings] 및 [System Settings]에 포함된 설정 항목에 해서는
“항목 및 사용 가능한 설정 옵션” (20페이지)을 참조하십시오.

4.  및  키를 사용하여 설정을 변경하려는 항목을 강조 표시한 다음 
키를 누릅니다.
• 선택한 항목에 한 설정 옵션 목록이 표시됩니다.
여기 화면은 [Input/Output]이 선택되었을 때 나타나는 예를 보여줍니
다.

5.  및  키를 사용하여 원하는 옵션을 강조 표시한 다음  키를 누릅
니다.

6. 원하는 로 설정된 후에  키를 누릅니다.

항목 및 사용 가능한 설정 옵션
“◆”는 초기 설정을 나타냅니다.

Calc Settings > Input/Output

계산기에서 표현식 입력 및 계산 결과 출력에 사용할 형식을 지정합니다.

MathI/MathO◆
입력: 자연수 텍스트북; 출력: 분수,
√  및/또는 π가 포함된 형식*1

MathI/DecimalO
입력: 자연수 텍스트북; 출력: 소수
값으로 변환됨

LineI/LineO 입력: 선형*2; 출력: 소수 또는 분수
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LineI/DecimalO
입력: 선형*2; 출력: 소수 값으로 변
환됨

*1 어떤 이유로 이러한 형식을 출력할 수 없는 경우 소수 출력이 적용됩니
다.

*2 분수와 함수를 포함한 모든 계산은 한 줄에 입력됩니다. 자연수 텍스트북
표시가 없는 모델과 동일한 출력 형식(S-V.P.A.M. 모델 등)

입력/출력 형식 표시 예:

MathI/MathO
(초기 설정)

MathI/DecimalO
(Number Format: Norm 1)

(Number Format: Norm 2)

LineI/LineO

LineI/DecimalO
(Number Format: Norm 1)

Calc Settings > Angle Unit

Degree◆; Radian; Gradian
값 입력 및 계산 결과 표시에 한 각도 단위로서 도, 라디안 또는 그레이드
를 지정합니다.

Calc Settings > Number Format

계산 결과를 표시하기 위한 자리수를 지정합니다.
Fix: 지정한 수치(0에서 9)로 표시되는 계산 결과의 소수점 이하의 자리수가
결정됩니다. 계산 결과는 표시 전에 지정된 자리수에서 반올림합니다.

예: 1 ÷ 6
(Fix 3)
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1 6 ( )*

Sci: 지정한 수치(1 에서 10)로, 표시되는 계산 결과의 유효자릿수가 결정됩
니다. 계산 결과는 표시 전에 지정된 자리수에서 반올림합니다.
예: 1 ÷ 6
(Sci 3)

1 6 ( )*

Norm: 계산 결과가 아래 범위에 해당하는 경우 지수 형식으로 표시합니다.
Norm 1◆: 10-2 > |x|, |x| ≥ 1010, Norm 2: 10-9 > |x|, |x| ≥ 1010

예: 1 ÷ 200
(Norm 1)

1 200 ( )*

(Norm 2)

1 200 ( )*

* 계산을 입력한 후에  신에 ( ) 키를 누르면 계산 결과를 소수
양식으로 표시합니다.

Calc Settings > Engineer Symbol

On; Off◆

공학 기호를 사용하여 계산 결과를 표시할지 여부를 지정합니다.

주의

• 이 설정에 해 On이 선택된 동안 인디케이터(E)가 화면 상단에 표시됩니다.

Calc Settings > Fraction Result

Mixed Fraction; Improp Fraction◆

계산 결과에서 분수 표시를 위해서 분수 또는 가분수 중의 하나를 지정합
니다.
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Calc Settings > Complex Result

a+bi◆; r∠θ
Complex 앱 계산 결과 및 Equation 앱 다항식 해에 한 직교좌표 또는 극
좌표를 지정합니다.

주의

• Complex Result 설정에 a+bi가 선택되어 있는 동안 화면 상단에 i 인디케이터가 표시됩
니다. r∠θ를 선택하면 ∠가 표시됩니다.

Calc Settings > Decimal Mark

Dot◆; Comma
계산 결과 소수점을 점으로 표시할 것인지, 콤마로 표시할 것인지 지정합니
다. 입력 중에는 항상 점으로 표시됩니다. 소수점으로 점(.)을 선택한 경우에
는 다수의 결과에 한 분리기호는 콤마(,)입니다. 콤마(,)를 선택한 경우에
는 분리기호가 세미콜론(;)입니다.

Calc Settings > Digit Separator

On; Off◆

계산 결과에 구분 문자를 사용해야 하는지 여부를 지정합니다.

System Settings > Contrast

“표시 콘트라스트 조정하기” (13페이지)를 참조하십시오.

System Settings > Auto Power Off

10 Min.◆; 60 Min.
Auto Power Off가 트리거될 때까지의 시간을 지정합니다.

System Settings > MultiLine Font

Normal Font◆; Small Font
Input/Output에 해 LineI/LineO 또는 LineI/DecimalO가 선택된 경우 표시
글꼴 크기를 지정합니다. Normal Font 선택 시 최  4줄, Small Font 선택
시 최  6줄 표시 가능합니다.
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System Settings > QR Code

(QR) 키를 눌렀을 때 표시되는 QR Code의 버전을 지정합니다.
Version 3: QR Code 버전 3을 나타냅니다.
Version 11◆: QR Code 버전 11을 나타냅니다.

Reset > Settings & Data

“계산기 설정 초기화하기” (24페이지)를 참조하십시오.

Reset > Variable Memory

“모든 메모리의 내용 삭제하기” (37페이지)를 참조하십시오.

Reset > Initialize All

“계산기 초기화하기” (7페이지)를 참조하십시오.

Get Started

“계산기 “Get Started” 화면” (7페이지)을 참조하시시오.

계산기 설정 초기화하기

중요!

• 아래 절차는 Contrast 및 Auto Power Off를 제외한 모든 계산기 설정을 초기화합니다.
또한 변수 메모리 및 Ans 데이터를 제외한 모든 데이터도 삭제합니다.

1.  키를 누르고 계산기 앱 아이콘을 선택한 후  키를 누릅니다.
2.  키를 누른 다음 [Reset] > [Settings & Data] > [Yes]를 선택합니다.

• 그러면 HOME 화면이 표시됩니다.

CATALOG 메뉴 사용하기
CATALOG 메뉴를 표시하려면  키를 누릅니다. 이 메뉴는 현재 사용하고
있는 계산기 앱과 앱의 현재 상태(표시된 화면 또는 현재 설정)에 따른 명령,
함수, 기호의 범주를 보여줍니다.
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예: Calculate 앱의 CATALOG 메뉴

주의

• CATALOG 메뉴에서 명령, 함수, 기호를 입력하는 방법에 한 정보는 “고급 계산” (45
페이지)을 참조하십시오.

• 각 계산기 앱의 명령, 함수, 기호에 한 정보는 “계산기 앱 사용하기” (65페이지)의 계
산기 앱 설명을 참조하십시오.

TOOLS 메뉴 사용하기
 키를 눌렀을 때 나타나는 TOOLS 메뉴에는 각 계산기 앱별 기능을 수행

하고 설정을 구성하기 위한 메뉴 항목이 포함되어 있습니다.

예: Calculate 앱용 TOOLS 메뉴

예: Table 앱용 TOOLS 메뉴

주의

• 아래 메뉴 항목은 여러 계산기 앱에 공통입니다.
- Undo(“조작 취소” (28페이지) 참조)
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식 및 값 입력하기

기본 입력 규칙
를 누르면 입력 계산의 우선 순위가 자동으로 평가되어서 결과가 표시됩

니다.

4 × sin 30 × (30 + 10 × 3) = 120

*1 sin 및 괄호를 포함하는 기타 함수에 해서는 닫는 괄호를 입력할 필요
가 있습니다.

*2 이들 승산 기호(×)는 생략할 수 있습니다.
*3  조작 직전의 닫는 괄호는 생략할 수 있습니다.

커서를 입력 표현식의 시작 또는 끝으로 이동

표현식을 입력하는 동안  키를 눌러서 커서를 표현식의 시작 부분으로 이
동하거나  키를 눌러서 표현식의 끝 부분으로 이동할 수 있습니다.

입력 표현식 및 계산 결과 “더 보기” 인디케이터(  , )

입력 표현식 라인이나 계산 결과 라인의 오른쪽에 포인터(  또는 ) 기호
가 있으면 표시된 라인이 오른쪽으로 계속된다는 의미입니다.  및  키
를 사용하여 라인을 좌우로 스크롤합니다.
• 계산 결과 라인의 오른쪽 끝에 가 표시되면  키를 눌러 결과의 끝으로
이동할 수 있습니다. 계산 결과 라인의 시작 부분으로 이동하려면  키를
누르십시오.

•  및  인디케이터가 표시된 때에 입력식을 스크롤하고자 하는 경우에
는  또는  키를 먼저 누른 후에  및  키를 눌러서 스크롤할 필요
가 있습니다.
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괄호 자동 완성

곱셈 기호가 생략된 상태에서 나눗셈과 곱셈 연산을 모두 포함하는 계산을
실행하면 아래 예와 같이 자동으로 괄호가 삽입됩니다.
- 여는 괄호 바로 앞이나 닫는 괄호 뒤에 곱셈 기호가 생략된 경우.
예: 6 ÷ 2(1 + 2) → 6 ÷ (2(1 + 2))

- 변수, 상수 등의 바로 앞에서 곱셈 부호가 생략된 경우.
예: 6 ÷ 2π → 6 ÷ (2π)

입력 제한 인디케이터

현재의 남은 입력이 10 바이트 이하로 되면 커서는 으로 형태가 바뀝니다.
이런 경우에는 계산 입력을 종료한 후 를 눌러 주십시오.

자연수 텍스트북 형식을 사용하여 표현
식 입력하기(MathI/MathO 또는 MathI/
DecimalO만 해당)
분수 및/또는 √ 와 같은 특수 함수가 포함된 표현식은 특정 키를 눌렀을 때,
또는 CATALOG 메뉴에서 특정 함수를 입력할 때 나타나는 템플릿을 사용
하여 자연수 텍스트북 형식으로 입력할 수 있습니다.

예: 3 1
2

 + 5 3
2

1. ( ) 키를 누릅니다.
• 이렇게 하여 분수 템플릿을 입력합니다.

2. 템플릿의 정수, 분자, 분모 영역에 값을 입력합니다.

3 1 2

3. 표현식의 나머지를 입력할 때도 동일하게 수행합니다.

( )5 3 2

주의

• 입력 커서가 템플릿( 분수, 적분(∫), 합(Σ))의 입력 영역 내에 있는 동안  키를 누
르면 템플릿 바로 다음 위치(오른쪽)로 이동하고,  키를 누르면 템플릿 바로 앞
위치(왼쪽)로 이동합니다.
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• 빈 프레임 영역이나 커서가 위치한 문자가 짙은 검정색이 되기 때문에 템플릿 내에서 커
서의 현재 위치를 항상 알 수 있습니다. 계산 표현식의 다른 모든 항목은 짙은 회색이 됩
니다.

조작 취소
마지막 키 조작을 취소하려면  키를 누르고 [Undo]를 선택한 후  키를
누릅니다.
방금 취소한 키 조작을 다시 실행하려면  키를 누르고 [Undo]를 선택한
다음 다시  키를 누릅니다.

값과 표현식을 인수로 사용하기

예: 1 + 7
6
을 입력한 후 1 + 로 변경하기

1 7 6 (INS)

위의 예에서 (INS) 키를 누르면 다음 키 조작(√ )에 의해 입력되는 함

수의 인수가 7
6
이 됩니다.

덮어쓰기 입력 모드(LineI/LineO 또는
LineI/DecimalO만 해당)
덮어쓰기 모드에서는 입력한 텍스트가 현재 커서의 위치에 있는 텍스트를
체합니다. 다음 조작으로 삽입 및 덮어쓰기 모드 간을 변환할 수 있습니
다: (INS). 커서는 삽입 모드에서 “ ”로 표시되고, 덮어쓰기 모드에서는
“ ”로 표시됩니다.
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표준 계산

산술 계산
, , ,  키를 사용하여 산술 계산을 합니다.

예: 7 × 8 - 4 × 5 = 36

7 8 4 5

분수 계산
분수의 입력 방법은 SETTINGS 메뉴의 현재 Input/Output 설정에 따라 다릅
니다.

7
3 (가분수) 입력하기

(Input/Output: MathI/MathO 또는 MathI/DecimalO)

7 3 또는 7 3 7
3

(Input/Output: LineI/LineO 또는 LineI/DecimalO)

7 3

(a) 분자, (b) 분모

2 1
3 ( 분수) 입력하기

(Input/Output: MathI/MathO 또는 MathI/DecimalO)

( )2 1 3 2 1
3

(Input/Output: LineI/LineO 또는 LineI/DecimalO)
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2 1 3

(a) 분자, (b) 분모, (c) 정수부

예: 2
3

 + 1 1
2

 = 13
6

(Input/Output: MathI/MathO)

2 3 ( )1 1 2

(Input/Output: LineI/LineO)

2 3 1 1 2

주의

• 계산 결과내의 분수는 약분한 후에 표시됩니다.

계산 결과 형식을 가분수 또는 분수로 변환하려면  키를 누릅니다. 추
가 정보는 “가분수 및 분수 변환” (41페이지)을 참조하십시오.

분수 형식 계산 결과

분수의 총 자릿수(정수, 분자, 분모, 구분 기호  포함)가 10보다 큰 계산
결과는 분수 형식을 사용하여 표시할 수 없습니다. 이 경우 계산 결과는 소
수 값으로 표시됩니다.

예 1: 1 1 123456 = 123457 123456

(Input/Output: LineI/LineO)

1 1 123456

값 1 1 123456의 총 자릿수는 10이므로 결과는 분수 값으로 표시됩니다.

예 2: 1 1 1234567 (= 1234568 1234567) = 1.00000081

(Input/Output: LineI/LineO)

1 1 1234567
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값 1 1 1234567의 총 자릿수는 11이므로 결과는 소수 값으로 표시됩니
다.

주의

• MathI/MathO 이외가 선택되어 있는 동안 계산에서 분수와 소수 값을 혼합하면 결과가
소수 값으로 표시됩니다.

누승, 누승근, 역함수
아래 키를 사용하여 누승 함수, 누승근 함수 및 역함수를 입력합니다.
누승 함수: (제곱), (nth 제곱)
누승근 함수: (제곱근), ( ) (nth 제곱근)
역함수:  ( )

예 1: (52)3 = 15625

5 3

예 2: (1 + 1)2+2 = 16

1 1 2 2

예 3: √2 × 3 = 3√2 = 4.242640687...
(Input/Output: MathI/MathO)

2 3

(Input/Output: LineI/LineO)

2 3

예 4: 5√32 = 2
(Input/Output: MathI/MathO)
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( ) 5 32

(Input/Output: LineI/LineO)

5 ( ) 32

예 5: 10-1 = 1
10

(Input/Output: MathI/MathO)

10 ( )

 키(10의 누승)

 키를 누르는 것은  키를 누르는 것과 같습니다. 두 조작 모두
“×10 ”(MathI/MathO 또는 MathI/DecimalO) 또는 “×10^(”(LineI/LineO 또는
LineI/DecimalO)을 입력합니다.

예: 1.23 × 103 = 1230

1 23 3

√  양식 계산 범위

√  양식 계산 결과의 허용 가능한 표시 범위는 다음과 같습니다.

± a√b, ± d ± a√b, ± a√b
c  ± d√e

f
1 ≤ a < 100, 1 < b < 1000, 1 ≤ c < 100
0 ≤ d < 100, 0 ≤ e < 1000, 1 ≤ f < 100

예:
• 10√2 + 15 × 3√3 = 45√3 + 10√2 ... √  양식으로 표시됨
• 99√999 (= 297√111) = 3129.089165 ... 소수 값으로 표시
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파이, 자연로그의 밑 e

파이

(π)를 눌러서 π를 입력합니다.
π는 3.141592654로 표시되지만 내부 계산에 해서는 π =
3.1415926535897932384626이 사용됩니다.

자연로그의 밑 e

(e)를 눌러서 e를 입력합니다.
자연로그의 밑 e는 2.718281828로 표시되지만 내부 계산에 해서는 e =
2.7182818284590452353602가 사용됩니다.

계산 이력 및 재생

계산 이력
화면 상단의  및/또는 는 위 및/또는 아래에 더 많은 계산 내역 내용을
나타냅니다.  및  키를 사용해서 계산 이력을 스크롤할 수 있습니다.

계산 이력을 지원하는 앱:
Calculate, Complex, Base-N

예

2 + 2 = 4

2 2

3 + 3 = 6

3 3

(뒤로 스크롤.)
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주의

• Input/Output 설정을 변경하거나 Reset 조작(“Settings & Data” 또는 “Initialize All”)을 수
행할 때마다  또는 를 누를 때마다 계산 이력 데이터가 모두 지워집니다.

재생

계산 결과가 표시되는 동안 ,  또는  키를 눌러서 이전 계산에서 사
용한 식을 편집할 수 있습니다.

예

4 × 3 + 2 = 14

4 3 2

4 × 3 - 7 = 5

(이어서)  7

주의

• 계산 결과 라인의 한쪽 끝 또는 양쪽 끝에 (왼쪽) 또는 (오른쪽)가 표시되면  및
 키를 사용하여 라인을 좌우로 스크롤할 수 있습니다. 이 경우 먼저  또는  키

를 누른 다음  및  키를 사용하여 표현식을 편집합니다.

메모리 함수 사용하기

앤서 메모리(Ans)
취득한 마지막 계산 결과는 Ans(앤서) 메모리에 저장됩니다.

Ans 메모리를 사용하여 일련의 계산 수행

예: 3 × 4의 결과를 30으로 나누기

3 4

(이어서)  30
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Ans 메모리 내용을 표현식에 입력하기

예: 아래에 표시된 계산 수행:

123 456

(이어서)  789

변수(A, B, C, D, E, F, x, y, z)

변수에 값을 저장하고, 계산에서 그 변수를 사용합니다.

변수 목록 화면

 누르면 현재 변수 A, B, C, D, E, F, x, y, z에 저장된 값을 보여주는 화면
이 표시됩니다. 이 화면에서 값은 항상 “Norm 1” Number Format을 사용하
여 표시됩니다. 화면을 닫으려면  또는  키를 누릅니다.

예 1: 3 + 5의 결과를 변수 A에 저장하기
1. 계산을 실행합니다.

3 5

2.  키를 누른 후 [A=] > [Store]를 선택합니다.
• 그러면 3 + 5(즉, 8)의 결과를 변수 A에 저장하니다.

3.  키를 누릅니다.

예 2: 변수 A의 내용을 1로 변경하기
1.  키를 누른 후 [A=]을 강조 표시합니다.

2.  키를 누릅니다.

35



• 그러면 1이 입력된 편집 화면이 표시됩니다.

3.  키를 누릅니다.

주의

• 위의 2단계 조작 신  키을 누른 다음 [Edit]를 선택할 수 있습니다. 그러면 아무것도
입력하지 않은 편집 화면을 표시합니다. 원하는 값을 입력한 후  키를 누릅니다.

• 변수 목록 화면에서 변수 강조 표시 시에 자물쇠( ) 아이콘이 나타나면 강조 표시된 변
수를 수정할 수 없음을 의미합니다.

예 3: 변수 A의 내용을 불러오기
(예 1의 2단계에서 계속)
1.  키를 누른 후 [A=] > [Recall]을 선택합니다.

• 그러면 “A”가 입력됩니다.

2.  키를 누릅니다.
• 그러면 변수 A의 값을 불러옵니다.

예 4: 변수 A의 내용을 10배 승산하기
(예 1의 2단계에서 계속)

(A)* 10

* 여기에 표시된 로 변수를 입력합니다:  키를 누른 다음 원하는 변수
이름에 해당하는 키를 누릅니다. 변수 이름으로 x를 입력하려면 (x)
또는  키를 누를 수 있습니다.
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모든 메모리의 내용 삭제하기
 키를 누르거나 계산기 앱을 변경하거나 계산기의 전원을 꺼도 Ans 메모

리 및 변수 내용은 유지됩니다.
모든 메모리의 내용을 삭제하려면 아래 절차를 수행하십시오.
1.  키를 누르고 계산기 앱 아이콘을 선택한 후  키를 누릅니다.
2.  키를 누른 다음 [Reset] > [Variable Memory] > [Yes]를 선택합니다.
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계산 결과 형식 변경하기

FORMAT 메뉴 사용하기
 키를 누르면 표시되는 FORMAT 메뉴를 사용하여 표시된 계산 결과를

다양한 형식으로 변환할 수 있습니다.

FORMAT 메뉴 목록

이 메뉴 항목: 이 형식으로 변환:

Standard Standard (분수, π, √  형식 포함.)

Decimal 소수

Prime Factor 소인수 분해

Rectangular Coord 직교좌표

Polar Coord 극좌표

Improper Fraction 가분수

Mixed Fraction 분수

ENG Notation
공학 표기(a×10n 형식, n = 3으로 나눌
수 있는 지수)

Sexagesimal 도, 분, 초(60 진수)

주의

•  키를 눌렀을 때 나타나는 메뉴 항목은 현재 표시된 계산 결과에 따라 다릅니다. 또
한 변환할 수 없는 계산 결과가 표시되면  키를 눌러도 메뉴가 나타나지 않습니다.
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변환 샘플 조작

예: 3 ÷ 2 = 3
2

 = 1.5 = 1 1
2

이 예에서는 가분수로 표시된 계산 결과를 소수 값으로 변환한 다음 분수
로 변환합니다. 마지막으로 변환을 취소하고 원래 계산 결과로 돌아갑니다.
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

1. 3 ÷ 2 계산을 실행합니다.

3 2

2. 계산 결과를 소수 값으로 변환하려면  키를 누르고 [Decimal]을 선택한
후  키를 누릅니다.

3. 계산 결과를 분수로 변환하려면  키를 누르고 [Mixed Fraction]을 선
택한 후  키를 누릅니다.

4. 변환을 취소하려면  키를 누릅니다.
• 그러면 1단계의 원래 계산 결과를 표시합니다.

Standard 및 Decimal 변환
Standard는 분수, √  또는 가능한 경우 π가 포함된 양식으로 계산 결과를 표
시하는 형식입니다. Decimal은 계산 결과를 소수 값으로 표시하는 형식입
니다.

주의

• SETTINGS 메뉴의 Input/Output 설정에 MathI/MathO 또는 MathI/DecimalO를 선택한
경우 √  또는 π가 포함된 Standard 형식으로 변환할 수 있습니다.
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아래 조작을 사용하여 계산 결과를 Standard 또는 Decimal 형식으로 변환
할 수 있습니다.

예: π ÷ 6 = 1
6

 π = 0.5235987756 (Input/Output: MathI/MathO)

(π) 6

([Decimal]을 선택합니다.)

(소수 값으로 변환합니다.)

(Standard 형식으로 변환합니다.)

중요!

• 특정 계산 결과의 경우 FORMAT 메뉴에서 [Standard]를 선택하면 표시된 값이 변환되
지 않습니다.

MathI/MathO 또는 LineI/LineO가 선택된 상태에서 소수 값 계산 결
과 구하기

계산을 입력한 후에  신 ( ) 키를 누르십시오.

소인수 분해
Calculate 앱에서 10자리를 초과하지 않는 길이의 양의 정수를 소인수로 분
해할 수 있습니다.

예: 1014에 해 소인수 분해 수행하기
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1014

 – [Prime Factor]

주의

• 아래에 설명된 값 종류는 10자릿수 이하이더라도 인수분해할 수 없습니다.
- 값의 소인수 중 하나는 1,018,081 이상입니다.
- 값의 두 개 이상의 소인수가 세 자리 이상입니다.

• 인수분해할 수 없는 부분은 표시에서 괄호로 묶입니다.
예: 2036162 = 2 × (1018081)*

*1018081 = 10092

2036162
 – [Prime Factor]

직교좌표 및 극좌표 변환
복소수 계산 결과를 직교좌표(  - [Rectangular Coord]) 또는 극좌표(  -
[Polar Coord])로 변환할 수 있습니다. 이 변환 작업은 다음 중 하나의 경우
에 수행할 수 있습니다.
• Equation 앱 고차 방정식 해가 표시되는 동안(Equation 앱의  –

[Complex Roots] 설정에 해 On이 선택된 경우)
• Complex 앱 계산 결과가 표시되는 동안

실제 샘플 변환 조작은 아래 절을 참조하십시오.
“복소수의 해를 직교좌표 또는 극좌표로 변환하기” (101페이지)
“복소수 계산 결과를 직교좌표 또는 극좌표로 변환하기” (107페이지)

가분수 및 분수 변환
현재 표시된 분수 또는 소수 값(이 계산기로 분수로 변환할 수 있는 소수 값)
계산 결과를 분수 또는 가분수로 변환할 수 있습니다.

예 1: 13
4

 = 3 1
4

(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

13 4
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 – [Mixed Fraction]

 – [Improper Fraction]

예 2: 3.25 = 13
4

 = 3 1
4

 (Input/Output: LineI/LineO)

3 25

 – [Improper Fraction]

 – [Mixed Fraction]

공학 표기
표시된 계산 결과 값의 지수 부분을 3의 배수인 10의 누승으로 변환하고 결
과를 표시할 수 있습니다.

예: 값 1234를 소수점을 우측으로 이동시킨 후 왼쪽으로 이동시켜서 공학
표기로 변환합니다.
1. 1234를 입력하고  키를 누릅니다.

2. 다음 조작을 수행하여 ENG 변환 모드로 들어갑니다.

 – [ENG Notation]

• ENG 변환 모드에 들어가면 계산 결과가 공학 표기로 변환되고 가오
른쪽에 표시됩니다.

• ENG 변환 모드에서  및 를 사용하여 가수의 소수점을 이동할 수
있습니다.
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3. ENG 변환 모드를 종료하려면 를 누르십시오.
• 그러면 ENG 변환 모드를 종료하고 디스플레이에서 가 사라집니다.

•  또는  키를 눌러 ENG 변환 모드를 종료할 수도 있습니다.

주의

• ENG 변환 모드에서는 정상적인 계산이 불가능합니다. 새 계산을 시작하려면 ENG 변
환 모드를 종료하십시오.

• 공학 기호를 사용하여 공학 표기를 표시할 수도 있습니다. 자세한 내용은 “공학 기호”
(55페이지)를 참조하십시오.

60진수 변환(도, 분, 초 계산)
10진수 값 계산 결과를 60진수 값으로 변환할 수 있습니다.

10진수 값 계산 결과를 60진수 값으로 변환하기
예: 1.25 = 1°15’0”

1 25

 – [Sexagesimal]

60진수 값 입력 및 계산하기
표시된 값을 60진수 값으로 변환하는 것 외에도 60진수 값을 입력하여 계산
에 사용할 수도 있습니다.
아래 구문은 60진수 값을 입력하기 위한 것입니다:

{도} ( ) {분} ( ) {초} ( )
도와 분은 0이더라도 항상 무언가를 입력해야 합니다.

예: 2°20’30” + 9’30” 계산 수행하기. 다음으로 계산 결과를 소수 값으로 변
환합니다.
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2 ( )20 ( )30 ( )
0 ( )9 ( )30 ( )

(소수 값으로 변환합니다.)
 – [Decimal]

(60진수 표시로 돌아갑니다.)
 – [Sexagesimal]
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고급 계산
이 절에서는 모든 계산기 앱에 공통적인 명령, 함수, 기호에 해 설명합니
다. 여기에서 명령, 함수, 기호를 표시하는 데 사용된 순서는  키를 누를
때 나타나는 CATALOG 메뉴에 표시되는 순서와 동일합니다.

주의

• 여기에 표시되지 않은 특정 계산기 앱 CATALOG 메뉴 항목도 있습니다. 특정 앱 메뉴
항목에 한 추가 정보는 각 계산기 앱의 장을 참조하십시오.

• 사용 중인 계산기 앱과 계산기 앱이 표시하는 화면에 따라 일부 명령, 함수, 기호를 입력
하지 못할 수 있습니다. 입력할 수 없는 명령, 함수, 기호는 CATALOG 메뉴에 나타나지
않습니다.

• 여기에 설명된 명령, 함수, 기호는 Base-N 앱에서 사용할 수 없습니다.

함수 분석
이 절에서는 조작을 수행한 후 입력할 수 있는 명령 및 함수에 해 설명합
니다:  – [Func Analysis].

Derivative(d/dx)

Derivative(d/dx)는 입력 f(x) 표현식에서 지정된 x-좌표(a)에서 근사 미분 계
수를 구합니다.

주의

• 이 함수는 다음 계산기 앱과 함께 사용할 수 있습니다: Calculate, Statistics,
Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.

입력 구문

입력 구문은 아래 표와 같이 SETTINGS 메뉴의 Input/Output 설정에 따라
다릅니다.

Input/Output 설정 입력 구문

MathI/MathO 또는 MathI/DecimalO
 d
dx (f(x))|x=a

LineI/LineO 또는 LineI/DecimalO
 d
dx (f(x), a, tol)*
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* tol에 해 아무 것도 입력되지 않은 경우에 1 × 10-16으로 되는 오차를 tol
이 지정합니다.

도함수 계산 주의사항

• f(x)에서 삼각함수를 사용할 때 SETTINGS 메뉴에서 “Radian”을 Angle
Unit으로 지정합니다.

• tol값이 작을수록 정밀도를 높이지만, 계산 시간 또한 증가합니다. tol을
지정할 때에는 1 × 10-22 이상인 값을 사용해 주십시오.

• 부정확한 결과와 에러는 다음에 의해 발생할 수 있습니다:
- x 값의 불연속 점
- x 값의 극단적인 변화
- x 값에 지역 최 점과 지역 최소점 포함
- x 값에 변곡점 포함
- x 값에 미분할 수 없는 점 포함
- 0에 가까운 미분 계산 결과

도함수 계산 예

f(x) = sin(x)일 때 f’( π
2

)를 결정합니다(tol 지정 생략).

(Input/Output: MathI/MathO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(π) 2

(Input/Output: LineI/LineO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(,) (π) 2

Integration(∫)
이 계산기는 수치 적분의 가우스-크론로드(Gauss-Kronrod) 방법을 사용하
여 적분을 수행합니다.

주의

• 이 함수는 다음 계산기 앱과 함께 사용할 수 있습니다: Calculate, Statistics,
Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.
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입력 구문

입력 구문은 아래 표와 같이 SETTINGS 메뉴의 Input/Output 설정에 따라
다릅니다.

Input/Output 설정 입력 구문

MathI/MathO 또는 MathI/DecimalO

LineI/LineO 또는 LineI/DecimalO

* tol에 해 아무 것도 입력되지 않은 경우에 1 × 10-10으로 되는 오차를 tol
이 지정합니다.

적분 계산 주의사항

• f(x)에서 삼각함수를 사용할 때 SETTINGS 메뉴에서 “Radian”을 Angle
Unit으로 지정합니다.

• tol값이 작을수록 정밀도를 높이지만, 계산 시간 또한 증가합니다. tol을
지정할 때에는 1 × 10-22 이상인 값을 사용해 주십시오.

• f(x)의 내용, 적분 영역 또는 적분 영역 내의 양수 및 음수 값에 따라 큰 에
러는 계산된 적분 값을 초래할 수 있습니다. (예: 불연속 점이 있거나 갑작
스런 변화가 있는 부분이 있을 때. 적분 범위가 너무 넓은 경우.) 이러한
경우 적분 구간을 여러 부분으로 나눈 다음 계산을 수행하면 계산 정확도
가 향상될 수 있습니다.

적분 계산 예

(ln(x), 1, e) = 1 (tol 지정 생략.)

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Integration(∫)]
(ln) 1 (e)

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Integration(∫)]
(ln) (,)1 (,) (e)
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Summation(Σ)

Σ(를 사용하면 특정 범위에 한 입력 f(x) 표현식의 합을 구할 수 있습니다.

주의

• 이 함수는 다음 계산기 앱과 함께 사용할 수 있습니다: Calculate, Statistics,
Distribution, Spreadsheet, Table, Equation(Solver 제외), Inequality, Matrix, Vector,
Ratio.

입력 구문

입력 구문은 아래 표와 같이 SETTINGS 메뉴의 Input/Output 설정에 따라
다릅니다.

Input/Output 설정 입력 구문

MathI/MathO 또는 MathI/DecimalO

LineI/LineO 또는 LineI/DecimalO

* a 및 b는 -1 × 1010 < a ≤ b < 1 × 1010 범위 내에서 지정할 수 있는 정수입니
다.

Σ 계산 예

 (x + 1) = 20

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Summation(Σ)]
1 1 5

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Summation(Σ)]
1 (,)1 (,)5

Logarithm(logab), Logarithm(log)
(log) 또는  – [Func Analysis] > [Logarithm(log)]를 사용하여 logab

를 log(a, b)로 입력합니다. a에 해 아무것도 입력하지 않으면 초기 설정으
로 10이 밑으로 사용됩니다.
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예 1: log101000 = log 1000 = 3

(log)1000

예 2: log216 = 4

(log)2 (,)16

 키(또는  – [Func Analysis] > [Logarithm(logab)])도 입력에 사용할 수
있지만 SETTINGS 메뉴의 Input/Output에 해 MathI/MathO 또는 MathI/
DecimalO가 선택된 경우에만 가능합니다. 이런 경우에는 기저에 한 값을
입력해야 합니다.

예 3: log216 = 4

2 16

Natural Logarithm
(ln) 또는  – [Func Analysis] > [Natural Logarithm]을 사용하여 “ln”

을 입력합니다.

예: ln 90 (= loge90) = 4.49980967

(ln)90

확률

이 절에서는 조작을 수행한 후 입력할 수 있는 명령 및 함수에 해 설명합
니다:  – [Probability].

%
% 명령 다음에 값을 입력하면 입력 값이 퍼센트가 됩니다.

주의

• Complex 앱으로 %를 입력할 수 없습니다.
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예 1: 150 × 20% = 30

150 20
 – [Probability] > [%]

예 2: 660은 880의 몇 퍼센트인가를 구한다. (75%)

660 880
 – [Probability] > [%]

예 3: 3500의 25% 감소를 구한다. (2625)

3500 3500 25
 – [Probability] > [%]

Factorial(!)
이 함수는 0 또는 양의 정수인 값의 계승을 구합니다.

예: (5 + 3)! = 40320

5 3
 – [Probability] > [Factorial(!)]

Permutation(P), Combination(C)
순열(nPr)과 조합(nCr) 함수.

예: 10개의 그룹으로부터 4명을 선택할 때에 가능한 순열 및 조합의 수를 결
정하려면

순열:

10
 – [Probability] > [Permutation(P)]

4

조합:

10
 – [Probability] > [Combination(C)]

4
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Random Number
이 함수는 0.000~0.999 범위에서 의사 난수를 생성합니다. SETTINGS 메
뉴의 Input/Output에 해 MathI/MathO를 선택하면 결과가 분수로 표시됩
니다.

주의

• Ran#은 Equation 앱의 Solver로 입력할 수 없습니다.

예: 3자리 정수의 난수 구하기

1000
 – [Probability] > [Random Number]

(결과는 각 실행마다 다릅니다.)

Random Integer
이 함수는 지정된 시작 값과 끝 값 사이에 의사 난수 정수를 생성합니다.

주의

• RanInt#은 Equation 앱의 Solver로 입력할 수 없습니다.

예: 1~6 사이의 난수 정수를 생성하기

 – [Probability] > [Random Integer]
1 (,)6

(결과는 각 실행마다 다릅니다.)

수치 계산
이 절에서는 조작을 수행한 후 입력할 수 있는 명령 및 함수에 해 설명합
니다:  – [Numeric Calc].

Absolute Value
실수 계산을 수행할 때 이 함수는 단순히 절 값을 구합니다.

예: |2 - 7| = Abs(2 - 7) = 5
(Input/Output: MathI/MathO)
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 – [Numeric Calc] > [Absolute Value]
2 7

(Input/Output: LineI/LineO)

 – [Numeric Calc] > [Absolute Value]
2 7

Round Off
Round Off 함수(Rnd)를 사용하면 현재의 Number Format 설정에 따라 인수
의 소수 값이 반올림됩니다. 예를 들어 Number Format 설정이 Fix 3인 경우
Rnd(10 ÷ 3)의 내부 및 표시 결과는 3.333입니다. Norm 1 또는 Norm 2 설
정을 사용하면 인수가 가수 부분의 11번째 자리에서 반올림됩니다.

예: 표시 자릿수로 Fix 3이 선택되었을 때 다음 계산을 실행하기: 10 ÷ 3 × 3
및 Rnd(10 ÷ 3) × 3
(Input/Output: MathI/DecimalO, Number Format: Fix 3)

10 3 3

 – [Numeric Calc] > [Round Off]
10 3 3

각도 단위, 극좌표/직교좌표, 60진수
이 절에서는 조작을 수행한 후 입력할 수 있는 명령, 함수, 기호에 해 설명
합니다:  – [Angle/Coord/Sexa].

Degrees, Radians, Gradians
이들 함수는 각도 단위를 지정합니다.
°는 도, r 라디안, g 그레이드를 지정합니다.
아래 메뉴 항목을 사용하여 각 함수를 입력할 수 있습니다.

 – [Angle/Coord/Sexa] > [Degrees]
 – [Angle/Coord/Sexa] > [Radians]
 – [Angle/Coord/Sexa] > [Gradians]

예: π/2 라디안 = 90° (Angle Unit: Degree)
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(π) 2
 – [Angle/Coord/Sexa] > [Radians]

Rect to Polar, Polar to Rect
“Pol(”은 직교좌표를 극좌표로 변환하며, “Rec(”는 극좌표를 직교좌표로 변
환합니다.

• 계산을 수행하기 전에 SETTINGS 메뉴에서 Angle Unit을 지정하십시오.
• r 및 θ, 그리고 x 및 y에 한 계산 결과는 각각 변수 x 및 y에 저장됩니다.
• 계산 결과 θ는 -180° < θ ≤ 180°의 범위에서 표시됩니다.

주의

• Pol(과 Rec(는 아래 계산기 앱의 계산 화면에서 사용할 수 있습니다.•
Calculate, Statistics, Matrix, Vector

예 1: 직교좌표(√2, √2)를 극좌표로 변환하기(Input/Output: MathI/MathO,
Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Rect to Polar]
2 (,) 2

예 2: 극좌표(√2, 45°)를 직교좌표로 변환하기(Input/Output: MathI/MathO,
Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Polar to Rect]
2 (,) 45

도, 분, 초
아래의 키 또는 메뉴 항목을 사용하여 60진수 기호를 입력할 수 있습니다
( ).

( )
 – [Angle/Coord/Sexa] > [Degs Mins Secs]

자세한 내용은 “60진수 변환(도, 분, 초 계산)” (43페이지)을 참조하십시오.
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쌍곡선, 삼각
이 절에서는 쌍곡선 및 삼각 함수에 해 설명합니다.

쌍곡선 함수
쌍곡선 함수는 아래 메뉴 항목을 사용하여 입력할 수 있습니다.

 – [Hyperbolic/Trig] > [sinh], [cosh], [tanh], [sinh-1], [cosh-1], 또는
[tanh-1]

각도 단위 설정은 계산에 영향을 주지 않습니다.

예: sinh 1 = 1.175201194

 – [Hyperbolic/Trig] > [sinh] 1

삼각 함수
삼각 함수는 아래 키 또는 메뉴 항목을 사용하여 입력할 수 있습니다.

키 메뉴 항목

 – [Hyperbolic/Trig] > [sin]

 – [Hyperbolic/Trig] > [cos]

 – [Hyperbolic/Trig] > [tan]

(sin-1)  – [Hyperbolic/Trig] > [sin-1]

(cos-1)  – [Hyperbolic/Trig] > [cos-1]

(tan-1)  – [Hyperbolic/Trig] > [tan-1]

계산을 수행하기 전에 SETTINGS 메뉴에서 Angle Unit을 지정하십시오.

예: sin 30 = 1
2

 (Angle Unit: Degree)

30
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공학 기호
계산기는 값 입력 또는 계산 결과 표시에 사용할 수 있는 11개의 공학 기호
(m, μ, n, p, f, k, M, G, T, P, E)의 사용을 지원합니다.
• 공학 기호는 조작을 수행한 후 입력할 수 있습니다:  – [Engineer

Symbol].
• 공학 기호로 계산 결과를 표시하려면 다음 조작을 수행하십시오:  –

[Calc Settings] > [Engineer Symbol] > [On].

공학 기호를 사용한 입력 및 계산 예

예 1: 500k 입력하기
(Engineer Symbol: On)

500  – [Engineer Symbol] > [Kilo] 

예 2: 999k(킬로) + 25k(킬로) = 1.024M(메가) = 1024k(킬로) = 1024000 계
산하기

(Engineer Symbol: On)

999  – [Engineer Symbol] > [Kilo] 
25  – [Engineer Symbol] > [Kilo] 

 – [ENG Notation]
(ENG 변환 모드 진입)

• , , 또는  키를 누르면 ENG 변환 모드를 종료하고 디스플레이
에서 가 사라집니다. 새 계산을 시작하려면 ENG 변환 모드를 종료하
십시오.

• ENG 변환 모드에 한 자세한 내용은 “공학 표기” (42페이지)를 참조
하십시오.
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과학 상수
계산기에는 47개의 과학 상수가 내장되어 있습니다. 값은 CODATA (2018)
추천값에 준거한 것입니다.

예: 과학 상수 c(진공중의 광속도)를 입력해서 그 값을 표시하기
1.  키를 눌러서 [Sci Constants]를 선택한 후  키를 누릅니다.

• 그러면 과학 상수 범주* 메뉴가 표시됩니다.

2. [Universal]을 선택한 후  키를 누릅니다.
• 그러면 Universal 범주의 과학 상수 메뉴가 표시됩니다.

3. [c]를 선택한 후  키를 누릅니다.

4.  키를 누릅니다.

* 아래 표는 각 범주에 포함된 과학적 상수를 보여줍니다.

범주 과학 상수

Universal h, , c, ε0, μ0, Z0, G, lP, tP

Electromagnetic μN, μB, e, Φ0, G0, KJ, RK

Atomic&Nuclear
mp, mn, me, mμ, a0, α, re, λC, γp,
λCp, λCn, R∞, μp, μe, μn, μμ, mτ

Physico-Chem mu, F, NA, k, Vm, R, c1, c2, σ

Adopted Values gn, atm, RK-90, KJ-90

Other t
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단위 변환
단위 변환 명령을 사용하여 한 측정 단위에서 다른 측정 단위로 변환할 수
있습니다. 변환식 데이터는 “NIST Special Publication 811 (2008)”에 준거
하고 있습니다.

예: 5cm를 인치로 변환하기(Input/Output: LineI/LineO)
1. 변환할 값을 입력합니다.

5

2.  키를 눌러서 [Unit Conversions]를 선택한 후  키를 누릅니다.
• 그러면 단위 변환 범주* 메뉴가 표시됩니다.

3. [Length]를 선택한 후  키를 누릅니다.
• 그러면 Length 범주의 변환 명령 메뉴가 표시됩니다.

4. [cm in](센티미터에서 인치로 변환 명령)를 선택한 다음  키를 누릅니
다.

5.  키를 누릅니다.

* 아래 표는 각 범주에 포함된 단위 변환 명령을 보여줍니다.

범주 단위 변환 명령

Length
in cm, cm in, ft m, m ft, yd m, m

yd, mile km, km mile, n mile m,
m n mile, pc km, km pc

Area acre m2, m2 acre

Volume
gal(US) L, L gal(US), gal(UK) L, L

gal(UK)
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*1

*2

*3

Mass oz g, g oz, lb kg, kg lb

Velocity km/h m/s, m/s km/h

Pressure
atm Pa, Pa atm, mmHg Pa, Pa
mmHg, kgf/cm2 Pa, Pa kgf/cm2,
lbf/in2 kPa, kPa lbf/in2

Energy kgf m J, J kgf m, J cal15, cal15 J

Power hp kW, kW hp

Temperature °F °C, °C °F

기타

계산기 키로 입력할 수 있는 함수 및 기호는 [Other] 메뉴를 사용해서도 입
력할 수 있습니다.  – [Other]를 사용하여 함수 및 기호 메뉴를 표시합니
다. 예를 들어 Ans를 입력하려면  키를 누르거나 다음 작업을 수행할 수
있습니다:  – [Other] > [Ans].
아래 표는 각 키 조작에 해당하는 [Other] 메뉴 항목을 보여줍니다.

메뉴 항목 키

Ans

π (π)

e (e)

√ (

x√ ( ( )

-1 ( )

2

^(

- ((-))

, (,)
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(

)

*1 역함수
*2 제곱
*3 마이너스 기호
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f(x) 및 g(x)에 한 정의 방정식 등
록 및 사용하기

f(x) 및 g(x)에 한 정의 방정식 등록 및
사용하기

계산기에는 정의 방정식을 등록한 후 사용할 수 있는 “f(” 및 “g(” 함수가 포
함되어 있습니다. 예를 들어 f(x) = x2 + 1을 “f(” 함수의 정의 방정식으로 등
록한 후 f(0) = 1 및 f(5) = 26을 계산할 수 있습니다.

 키를 누르면 f(x) 또는 g(x)의 정의 방정식을 등록하고 “f(” 또는 “g(”를 입
력하기 위한 메뉴가 표시됩니다.

주의

• f(x) 및 g(x)의 정의 방정식은 Table 앱의 f(x) 및 g(x)에서도 사용됩니다. Table 앱에 한
정보는 “수치표 생성하기” (92페이지)를 참조하십시오.

정의 방정식 등록하기
예 1: f(x) = x2 + 1 등록하기
1.  키를 누르고 Calculate 앱 아이콘을 선택한 후  키를 누릅니다.
2.  키를 누른 후 [Define f(x)]를 선택합니다.

• 그러면 f(x) 방정식 입력 화면이 표시됩니다.

3. x2 + 1을 입력하십시오.

1

4.  키를 누릅니다.
• 그러면 입력한 표현식이 등록되고 이 절차의 2단계에서  키를 누르
기 전에 표시되었던 화면이 다시 나타납니다.

주의

• 정의 방정식은 Distribution, Equation(Simul Equation / Polynomial), Inequality, Base-N,
Ratio, Math Box를 제외한 모든 계산기 앱에서 등록할 수 있습니다. 단, 계산기 앱이 표
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시하는 화면(예: 메뉴 화면이 표시된 경우)에 따라  키를 눌러도 메뉴가 표시되지 않
을 수 있습니다.

등록된 정의 방정식에 값을 할당하여 계산 수행하기
예 2: 예제 1에서 등록한 f(x)에 값 x = 3 할당하기
(예 1에서 계속)
1.  키를 누른 후 [f(x)]를 선택합니다.

• 이렇게 하여 “f(”를 입력합니다.

2. 값 3을 할당한 다음 계산을 실행합니다.

3

합성 함수 등록하기
예 3: g(x) = f(x) × 2 - x를 등록하기 위해 예제 1에서 정의한 f(x)를 g(x)에 삽
입하기

(예 1에서 계속)
1.  키를 누른 후 [Define g(x)]를 선택합니다.

• 그러면 g(x) 방정식 입력 화면이 표시됩니다.

2. f(x) × 2 - x를 입력합니다.

* 2

* g(x) 방정식 등록 화면이 표시된 상태에서  키를 누르면 나타나는 메
뉴 항목은 [f(x)]뿐입니다. 같은 방법으로 f(x) 방정식 등록 화면이 표시된
상태에서  키를 누르면 나타나는 메뉴 항목은 [g(x)]뿐입니다.

3.  키를 누릅니다.
• 그러면 입력한 방정식을 등록하고 1단계에서 이 조업을 시작하기 전에
표시된 화면으로 돌아갑니다.

주의

• g(x)의 x에 값을 할당하고 결과를 계산하는 조작은 “등록된 정의 방정식에 값을 할당하
여 계산 수행하기” (61페이지)에서와 동일합니다. 단, 1단계에서 [f(x)]를 선택하는 신
[g(x)]를 선택해야 합니다.

• 예 3의 조작에서는 g(x)의 정의식에 f(x)를 입력합니다. 반 로 f(x) 정의 방정식에 g(x)를
입력할 수도 있습니다. 단, f(x)에 g(x) 입력 및 g(x)에 f(x) 입력을 동시에 하지 마십시오.
그렇게 하면f(x) 또는 g(x)를 사용하여 계산을 수행할 때 Circular ERROR가 발생합니다.
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데이터 보존
아래 조작 중 하나를 수행하면 f(x) 및 g(x)에 등록된 정의 방정식이 삭제됩니
다.

•  키 누르기
• SETTINGS 메뉴를 사용하여 Input/Output 설정을 MathI*1과 LineI*2 사
이에서 전환합니다.
*1 MathI/MathO 또는 MathI/DecimalO
*2 LineI/LineO 또는 LineI/DecimalO

•  – [Reset] > [Settings & Data] 또는  – [Reset] > [Initialize All] 실
행하기
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QR Code 기능 사용하기

QR Code 기능 사용하기
계산기는 스마트 장치에서 읽을 수 있는 QR Code 기호를 표시할 수 있습니
다.

중요!

• 이 절의 조작에서는 사용 중인 스마트 장치에 여러 QR Code 기호를 읽을 수 있는 QR
Code 판독기가 있고 인터넷에 연결할 수 있다고 가정합니다.

• 이 계산기에 표시된 QR Code를 스마트 장치로 스캔하면 스마트 장치가 CASIO 웹사이
트에 액세스할 수 있습니다.

주의

• 아래 화면 중 하나가 표시된 상태에서 (QR) 키를 누를 때마다 디스플레이에 QR
Code가 나타납니다.
- HOME 화면
- SETTINGS 메뉴 화면
- 에러 화면
- 모든 계산기 앱의 계산 결과 화면
- 모든 계산기 앱의 표 화면
- Spreadsheet 앱 화면
자세한 내용은 CASIO 웹사이트(https://wes.casio.com)를 참조하십시오.

QR Code 표시하기
예: 계산기의 Calculate 앱에서 계산 결과에 한 QR Code를 표시하고 스
마트 장치로 스캔하기
1. Calculate 앱에서 몇 가지 계산을 수행합니다.
2. (QR) 키를 눌러 QR Code를 표시합니다.

• 디스플레이의 오른쪽 하단 모서리에 있는 숫자는 현재 QR Code 번호
와 QR Code 기호의 총 개수를 나타냅니다. 다음 QR Code를 표시하려
면  또는  키를 누릅니다.

주의

• 이전 QR Code로 돌아가려면  또는  키를 필요한 만큼 눌러 나타날 때까지 앞
으로 스크롤합니다.

3. 스마트 기기를 사용하여 계산기 디스플레이의 QR Code를 스캔합니다.
• QR Code 스캔 방법에 한 정보는 사용 중인 QR Code 판독기의 사용
자 설명서를 참조하십시오.
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QR Code를 스캔하는 데 문제가 있는 경우
QR Code가 표시되는 동안  및  키를 사용하여 QR Code의 디스플레
이 콘트라스트를 조정합니다. 이 콘트라스트 조정은 QR Code 디스플레이
에만 영향을 줍니다.

중요!

• 사용 중인 스마트 장치 및/또는 QR Code 판독기 앱에 따라 이 계산기에서 생성된 QR
Code 기호를 스캔하는 데 문제가 발생할 수 있습니다.

• SETTINGS 메뉴의 “QR Code” 설정이 “Version 3”인 경우 QR Code 기호를 표시할 수
있는 계산기 앱이 제한됩니다. QR Code 표시를 지원하지 않는 앱에서 QR Code를 표
시하려고 하면 “Not Supported (Version 3)”라는 메시지가 나타납니다. 그러나 이 설정
으로 생성된 QR Code는 스마트 기기로 스캔하기가 더 쉽습니다.

• 추가 정보는 CASIO 웹사이트(https://wes.casio.com)를 참조하십시오.
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계산기 앱 사용하기

통계 계산
Statistics 앱은 일변수(x) 또는 이변수(x, y) 데이터를 기반으로 다양한 통계
값을 계산합니다.

통계 계산을 수행하기 위한 일반 절차
1.  키를 누르고 Statistics 앱 아이콘을 선택한 후  키를 누릅니다.
2. 나타나는 메뉴에서 [1-Variable](일변수) 또는 [2-Variable](이변수)를 선택
한 후 를 누릅니다.
• 그러면 통계 편집기가 표시됩니다.

일변수

이변수

3. 필요에 따라 Freq(도수) 열을 표시합니다.
• 자세한 내용은 “Freq(도수) 열” (66페이지)을 참조하십시오.

4. 데이터를 입력합니다.
• 자세한 내용은 “통계 편집기에 데이터 입력하기” (66페이지)를 참조
하십시오.

5. 데이터 입력이 끝나면  키를 누릅니다.
• 그러면 아래 메뉴가 나타납니다.

일변수
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이변수

6. 수행하려는 조작에 한 메뉴 항목을 선택합니다.
• [1-Var Results], [2-Var Results], 또는 [Reg Results]를 선택하여 입력한
데이터를 기반으로 하는 계산 결과 목록을 봅니다. 자세한 내용은 “통
계 계산 결과 표시” (69페이지)를 참조하십시오.

• 입력 데이터를 기반으로 계산을 수행하기 위한 통계 계산 화면을 표시
하려면 [Statistics Calc]를 선택합니다. 자세한 내용은 “통계 계산 화면
사용” (72페이지)를 참조하십시오.

주의

• 통계 계산 화면에서 통계 편집기로 돌아가려면  키를 누른 다음  키를 누릅니다.

통계 편집기에 데이터 입력하기
통계 편집기는 1개, 2개, 또는 3개의 열을 표시합니다: 일변수(x), 일변수 및
도수(x, Freq), 이변수(x, y), 이변수 및 도수(x, y, Freq). 입력할 수 있는 데이
터 행의 수는 열의 수에 따라 다릅니다: 한 열에는 160행, 두 열에는 80행,
세 열에는 53행.

중요!

• 아래 조작을 수행할 때마다 현재 통계 편집기에 입력된 모든 데이터가 삭제됩니다.
- 통계 계산 종류를 일변수와 이변수 간 전환
- TOOLS 메뉴의 Frequency 설정 변경

• 데이터 항목이 많은 경우 통계 계산에 상당한 시간이 소요될 수 있습니다.

Freq(도수) 열

TOOLS 메뉴에서 Frequency 설정을 켜면 “Freq”라는 열도 통계 편집기에
포함됩니다. Freq 열을 사용하여 각 표본 값의 도수(데이터 그룹에 동일한
표본이 나타나는 횟수)를 지정할 수 있습니다.

일변수
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이변수

Freq 열 표시하기
1. 통계 편집기가 표시된 상태에서  키를 누른 다음 [Frequency] > [On]을
선택합니다.

2.  키를 누르면 통계 편집기로 돌아갑니다.

Freq 열 숨기기
1. 통계 편집기가 표시된 상태에서  키를 누른 다음 [Frequency] > [Off]를
선택합니다.

2.  키를 누르면 통계 편집기로 돌아갑니다.

통계 편집기에서 표본 데이터 입력 규칙

입력한 데이터는 커서가 위치한 셀에 삽입됩니다. 커서 키를 사용하여 셀 사
이에서 커서를 이동합니다.

   커서

값을 입력한 후  키를 누릅니다. 그러면 값이 등록되고 셀에 최  6자리
숫자가 표시됩니다.

예 1: 이변수 선택해서 다음 데이터를 입력하기: (170, 66), (179, 75), (173,
68)
1.  키를 누르고 Statistics 앱 아이콘을 선택한 후  키를 누릅니다.
2. [2-Variable]을 선택한 후  키를 누릅니다.

3. 다음 조작을 통해 데이터를 입력합니다.

170 179 173
66 75 68
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주의

• 통계 편집기에서 셀의 값을 변수에 저장할 수 있습니다. 예를 들어 3단계의 화면이 위에
표시된 상태에서 다음 조작을 수행하면 변수 A에 68이 저장됩니다:  – [A=] >
[Store]. 변수에 한 자세한 내용은 “변수(A, B, C, D, E, F, x, y, z)” (35페이지)를 참조
하십시오.

표본 데이터 편집하기

셀의 데이터를 교체하기
통계 편집기에서 편집하고자 하는 데이터를 포함하고 있는 셀로 커서를 이
동시켜서 새로운 데이터를 입력한 후  키를 누릅니다.

행 삭제하기
통계 편집기에서 삭제할 행으로 커서를 이동한 후  키를 누릅니다.

행 삽입하기
1. 통계 편집기에서 삽입할 행의 아래가 될 행으로 커서를 이동합니다.
2. 다음과 같은 조작을 수행하십시오:  – [Edit] > [Insert Row].

모든 통계 편집기의 내용을 삭제하기
통계 편집기에서 다음 조작을 수행합니다:  – [Edit] > [Delete All].

데이터 정렬하기

통계 편집기 데이터를 x, y, 또는 Freq 열 값에서 오름차순 또는 내림차순으
로 정렬할 수 있습니다.

중요!

• 데이터 정렬 순서를 변경한 후에는 원래 순서로 되돌릴 수 없습니다.

예 2: 예 1 (67페이지)의 데이터 입력을 x열에서 오름차순으로 정렬한 다음
y열에서 내림차순으로 정렬하기
1. 예 1의 절차를 사용하여 데이터를 입력합니다.

2. x열에서 데이터를 오름차순으로 정렬합니다.

 – [Sort] > [x Ascending]
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3. y열에서 데이터를 내림차순으로 정렬합니다.

 – [Sort] > [y Descending]

통계 계산 결과 표시

단변수 통계 계산 결과 표시하기

1-Var Results 화면에는 일변수 데이터를 기반으로 계산된 다양한 통계 값
(예: 평균 및 모표준 편차)의 목록이 표시됩니다. 이 절에서는 1-Var Results
화면을 표시하는 데 필요한 조작에 해 설명합니다.

예 3: 아래 데이터를 입력하고 일변수 통계 계산 결과를 표시하기

x 1 2 3 4 5 6 7 8 9 10
Freq 1 2 1 2 2 2 3 4 2 1

1.  키를 누르고 Statistics 앱 아이콘을 선택한 후  키를 누릅니다.
2. [1-Variable]을 선택한 후  키를 누릅니다.

• 그러면 통계 편집기가 표시됩니다.
3.  키를 누른 후 [Frequency] > [On]을 선택합니다.

•  키를 누르면 통계 편집기로 돌아갑니다.
4. 데이터를 x열에 입력합니다.

1 2 3 4 5 6 7 8 9 10

5. 데이터를 Freq 열에 입력합니다.

2 2 2 2 3 4 2

6.  키를 누릅니다.

7. [1-Var Results]를 선택한 후  키를 누릅니다.
• 그러면 1-Var Results 화면을 표시합니다.
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 (또는 )

 (또는 )

• 1-Var Results 화면에 표시되는 변수의 의미는 “통계값 변수 및 통계 계
산 기능 목록” (75페이지)을 참조하십시오.

8.  또는  키를 누르면 통계 편집기로 돌아갑니다.

이변수 통계 계산 결과 표시하기

2-Var Results 화면에는 이변수 데이터를 기반으로 계산된 다양한 통계 값
(예: 평균 및 모표준 편차)의 목록이 표시됩니다. 이 절에서는 2-Var Results
화면을 표시하는 데 필요한 조작에 해 설명합니다.

예 4: 아래 데이터를 입력하고 이변수 통계 계산 결과를 표시하기

x 1.0 1.2 1.5 1.6 1.9 2.1 2.4 2.5 2.7 3.0
y 1.0 1.1 1.2 1.3 1.4 1.5 1.6 1.7 1.8 2.0

1.  키를 누르고 Statistics 앱 아이콘을 선택한 후  키를 누릅니다.
2. [2-Variable]을 선택한 후  키를 누릅니다.

• 그러면 통계 편집기가 표시됩니다.
3. 데이터를 x열에 입력합니다.

1 1 2 1 5 1 6 1 9
2 1 2 4 2 5 2 7 3

4. 데이터를 y열에 입력합니다.

1 1 1 1 2 1 3 1 4
1 5 1 6 1 7 1 8 2

5.  키를 누릅니다.

6. [2-Var Results]를 선택한 후  키를 누릅니다.
• 그러면 2-Var Results 화면을 표시합니다.
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 (또는 )

 (또는 )

 (또는 )

• 2-Var Results 화면에 표시되는 변수의 의미는 “통계값 변수 및 통계 계
산 기능 목록” (75페이지)을 참조하십시오.

7.  또는  키를 누르면 통계 편집기로 돌아갑니다.

회귀 계산 결과 표시하기

Reg Results 화면은 이변수 데이터를 기반으로 하는 회귀 계산 결과(회귀
방정식의 계수) 목록을 표시합니다. 이 절에서는 Reg Results 화면을 표시
하는 데 필요한 조작에 해 설명합니다.

예 5: 예 4 (70페이지)에서 이변수 데이터 입력을 사용하고 아래 표시된 두
회귀 계산의 결과를 표시하기
• 회귀 방정식 “y = a + bx” 계수(a, b) 및 데이터에 해 직선 회귀를 수행할
때 상관 계수(r)

• 데이터에 해 2차 회귀를 수행할 때 회귀 방정식 “y = a + bx + cx2” 계수
(a, b, c)

주의

• Statistics 앱에서 지원하는 회귀 계산 종류에 한 정보는 “지원되는 회귀 종류 목록”
(72페이지)을 참조하십시오.

1. 예 4 (70페이지)에서 절차의 1~5단계를 수행합니다.
2. [Reg Results]를 선택한 후  키를 누릅니다.

• 그러면 회귀 종류 메뉴가 표시됩니다.

3. [y=a+bx]를 선택한 후  키를 누릅니다.
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• 그러면 직선 회귀 Reg Results 화면이 표시됩니다.

4.  또는  키를 누르면 통계 편집기로 돌아갑니다.
5.  버튼을 누른 후 [Reg Results] > [y=a+bx+cx2]를 선택합니다.

• 그러면 2차 회귀 Reg Results 화면을 표시합니다.

6.  또는  키를 누르면 통계 편집기로 돌아갑니다.
• Reg Results 화면에 표시되는 변수의 의미는 “통계값 변수 및 통계 계
산 기능 목록” (75페이지)을 참조하십시오.

지원되는 회귀 종류 목록

회귀 종류
회귀 방정식

(회귀 종류 메뉴 항목)

직선 회귀 y = a + bx

2차 회귀 y = a + bx + cx2

수 회귀 y = a + b･ln(x)

e 지수 회귀 y = a･e^(bx)

ab 지수 회귀 y = a･b^x

누승 회귀 y = a･x^b

역수 회귀 y = a + b/x

통계 계산 화면 사용
통계 계산 화면을 사용하여 개별 통계 값을 불러오고 계산에 사용할 수 있습
니다.
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계산식 입력이 없는 화면

계산 예

통계 값을 불러오려면 불러오려는 통계 값을 나타내는 변수를 사용합니다
(예: x 평균: x, x 모표준 편차: σx, x 최 값: max(x) 등). 이러한 변수에 한
추가 정보는 “통계값 변수 및 통계 계산 기능 목록” (75페이지)을 참조하
십시오.

통계 계산 화면 표시하기

일변수

1. 통계 편집기가 표시되는 동안  키를 누릅니다.
2. 나타나는 메뉴에서 [Statistics Calc]를 선택한 후  키를 누릅니다.

이변수

1. 통계 편집기가 표시되는 동안  키를 누릅니다.
2. 나타나는 메뉴에서 [Statistics Calc]를 선택한 후  키를 누릅니다.

• 그러면 회귀 종류 메뉴가 표시됩니다(“지원되는 회귀 종류 목록” (72페
이지) 참조).

3. 메뉴에서 원하는 회귀 종류를 선택한 후  키를 누릅니다.
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• 위의 예에서 표시된 메뉴를 사용하여 [y=a+bx](직선 회귀)를 선택합니
다.

통계 계산 화면에서 통계 편집기로 돌아가기
 키를 누른 후  키를 누릅니다.

통계 계산 화면을 사용한 계산 예

예 6: 예 3 (69페이지)에서 입력된 일변수 데이터의 표본 데이터(Σx)와 평균
(x)의 합을 구하기
1. 예 3 (69페이지)에서 절차의 1~6단계를 수행합니다.
2. [Statistics Calc]를 선택한 후  키를 누릅니다.

3. 표본 데이터의 합을 계산합니다(Σx).

 – [Statistics] > [Summation] > [Σx]

4. 평균(x)을 구합니다.

 – [Statistics] >
[Mean/Var/Dev...] > [x]

주의

• 위의 통계 계산 화면에서 1-Var Results 화면을 표시하려면  키를 누른 다음 [1-Var
Results]를 선택합니다. 1-Var Results 화면에서 통계 계산 화면으로 돌아가려면  또
는  키를 누릅니다.

예 7: 예 4 (70페이지)에서 입력된 이변수 데이터를 기반으로 직선 회귀 방
정식 “y = a + bx”의 계수(a, b) 및 상관 계수(r) 결정하기
1. 예 4 (70페이지)에서 절차의 1~5단계를 수행합니다.
2. [Statistics Calc]를 선택한 후  키를 누릅니다.

• 그러면 회귀 종류 메뉴가 표시됩니다.
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3. [y=a+bx]를 선택한 후  키를 누릅니다.

4. 회귀 방정식 “y = a + bx”의 계수(a, b)와 상관 계수(r)를 결정합니다.

 – [Statistics] > [Regression] > [a]

 – [Statistics] > [Regression] > [b]

 – [Statistics] > [Regression] > [r]

• 다른 회귀 종류를 선택하려면  키를 누른 다음 [Select Reg Type]을
선택합니다. 그러면 2단계의 회귀 종류 메뉴가 표시됩니다.

통계 계산 화면에서 2-Var Results 화면을 표시하기
 키를 누른 다음 [2-Var Results]를 선택합니다.

통계 계산 화면에서 Reg Results 화면을 표시하기
 키를 누른 후 [Reg Results]를 선택합니다.

통계값 변수 및 통계 계산 기능 목록

CATALOG 메뉴를 사용하여 통계 계산에 사용되는 통계 값과 함수를 나타
내는 변수를 불러올 수 있습니다.

주의

• 일변수 통계 계산에 해서는 애스테리스크(*)가 표시된 변수를 사용할 수 있습니다.
• 각 변수 및 명령에 사용되는 계산식은 “통계 계산식” (78페이지)을 참조하십시오.

 – [Statistics] > [Summation]
Σx*, Σy ...... 표본 데이터의 합계
Σx2*, Σy2 ...... 표본 데이터의 제곱의 합계
Σxy ...... x-데이터 및 y-데이터의 곱의 합계
Σx3 ...... x-데이터의 세제곱의 합계
Σx2y ...... (x-데이터 제곱 × y-데이터)의 합계
Σx4 ...... x-데이터의 네제곱의 합계
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 – [Statistics] > [Mean/Var/Dev...]
x*, y ...... 평균
σ2x*, σ2y ...... 모분산
σx*, σy ...... 모표준 편차
s2x*, s2y ...... 표본 분산
sx*, sy ...... 표본 표준 편차
n* ...... 항목 수

 – [Statistics] > [Min/Max/Quartile] (일변수 데이터만 해당)
min(x)* ...... 최소값
Q1* ...... 제일사분위수
Med* ...... 중앙값
Q3* ...... 제삼사분위수
max(x)* ...... 최 값

 – [Statistics] > [Norm Dist] (일변수 데이터만 해당)
P(*, Q(*, R(*, t* ...... 정규 분포 계산을 실행하기 위한 함수입니다. 이러
한 함수에 한 추가 정보는 “정규 분포 계산 계산하기(일변수 데이터만
해당)” (77페이지)을 참조하십시오.

 – [Statistics] > [Min/Max] (이변수 데이터만 해당)
min(x), min(y) ...... 최소값
max(x), max(y) ...... 최 값

 – [Statistics] > [Regression] (이변수 데이터만 해당)

2차 회귀의 경우
a, b, c ...... 2차 회귀에 한 회귀 계수
x̂1, x̂2 ...... 입력 y-값에 한 x1 및 x2 추정값을 결정하기 위한 함수입니다.
인수의 경우 x̂1 또는 x̂2 함수 바로 앞에 y 값을 입력합니다.
ŷ ...... 입력 x-값에 한 y 추정값을 결정하기 위한 함수입니다. 인수의 경
우 이 함수 바로 앞에 x 값을 입력합니다.

비2차 회귀의 경우
a, b ...... 회귀 계수
r ...... 상관 계수
x̂ ...... 입력 y-값에 한 x 추정값을 결정하기 위한 함수입니다. 인수의 경
우 이 함수 바로 앞에 y 값을 입력합니다.
ŷ ...... 입력 x-값에 한 y 추정값을 결정하기 위한 함수입니다. 인수의 경
우 이 함수 바로 앞에 x 값을 입력합니다.
추정값을 결정하기 위한 조작의 예는 “추정값 계산하기(이변수 데이터만
해당)” (77페이지)을 참조하십시오.
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정규 분포 계산 계산하기(일변수 데이터만 해당)

일변수 통계 계산을 선택한 때에는  키를 누르고 [Statistics] > [Norm
Dist]를 선택할 때 표시되는 메뉴로부터 아래에 표시되는 함수를 사용해서
정규 분포 계산을 실행할 수 있습니다.

P(, Q(, R( ... 이들 함수는 인수 t를 가지며, 표준 정규 분포의 가능성을 아래
그림과 같이 결정합니다.

t ...... 이 함수 앞에는 인수 x가 옵니다. 통계 편집기로 입력한 데이터의 평
균값(x)과 모표준 편차(σx)를 사용하여 데이터 값 x에 한 표준 변량을 계산
합니다.

예 8: 예 3 (69페이지)의 일변수 데이터 입력의 경우 x = 2일 때 정규화된 변
량을 결정하고 해당 지점에서 P(t)를 결정합니다.
1. 예 3 (69페이지)에서 절차의 1~6단계를 수행합니다.
2. [Statistics Calc]를 선택한 후  키를 누릅니다.

3. x = 2일 때 정규화된 변량을 계산합니다.

2
 – [Statistics] > [Norm Dist] > [ t]

4. P(t)를 계산합니다.

 – [Statistics] > [Norm Dist] > [P(]

추정값 계산하기(이변수 데이터만 해당)

이변수 통계 계산으로 구한 회귀 방정식에 근거해서 주어진 x값에 해서 y
의 추정값을 계산할 수 있습니다. 응하는 x값(2차 회귀의 경우x1 및 x2의

두 개의 값)도 회귀 방정식 내에서 y값에 해서 계산할 수 있습니다.
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예 9: 예 4 (70페이지)의 데이터 입력의 직선 회귀에 의해서 생성된 회귀 방
정에서 x = 5.5일 때 y의 추정값 구하기
1. 예 4 (70페이지)에서 절차의 1~5단계를 수행합니다.
2. [Statistics Calc]를 선택한 후  키를 누릅니다.

• 그러면 회귀 종류 메뉴가 표시됩니다.

3. [y=a+bx]를 선택한 후  키를 누릅니다.

4. x-값(5.5)을 입력하고 y의 추정값을 결정하는 함수인 “ŷ”를 입력합니다.

5 5
 – [Statistics] > [Regression] > [ŷ]

5.  키를 누릅니다.

통계 계산식

일변수 통계 계산식

이변수 통계 계산식
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회귀 계산식

직선 회귀(y = a + bx)

2차 회귀(y = a + bx + cx2)

수 회귀(y = a + b･ln(x))
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e 지수 회귀(y = a･e^(bx))

ab 지수 회귀(y = a･b^x)

누승 회귀(y = a･x^b)

역수 회귀(y = a + b/x)
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분포 계산
Distribution 앱에서 분포 계산 종류를 선택하고 다양한 매개변수를 입력하
여 확률 값을 얻을 수 있습니다.* 실행 가능한 분포 계산 종류는 아래 표와
같습니다.

분포 계산 종류 메뉴 항목

2항 확률 Binomial PD

2항 누적 확률 Binomial CD

정규 확률 밀도 Normal PD

정규 누적 확률 Normal CD

역정규 누적 확률* Inverse Normal

푸아송 확률 Poisson PD

푸아송 누적 확률 Poisson CD

* “Inverse Normal”은 확률 값(Area)에서 데이터 값(xInv)을 결정하기 위해
역계산을 수행합니다.

분포 계산을 수행하기 위한 일반 절차
예: N(시도 횟수) = 5 및 p(성공 확률) = 0.5일 때 x 데이터 {2, 3, 4, 5}에 한
2항 누적 확률 계산하기

1.  키를 누르고 Distribution 앱 아이콘을 선택한 다음  키를 누릅니다.
• 그러면 분포 계산 종류 메뉴가 표시됩니다.
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2. 메뉴에서 분포 계산 종류를 선택합니다.
• 여기에서 2항 누적 확률을 계산하려고 합니다. [Binomial CD]를 선택한
후  키를 누릅니다.

3. 나타나는 메뉴에서 데이터(x) 입력 방식을 선택합니다.

[List] ... 여러 x-데이터 항목을 동시에 입력하려면 선택합니다. 이 메뉴 항
목을 선택하면 목록 화면이 나타납니다.

[Variable] ... 단일 x-데이터 항목을 입력하려면 선택합니다. 이 메뉴 항목
을 선택하면 매개변수 입력 화면이 나타납니다.

• 여기서 여러 개의 x-데이터 항목을 동시에 입력하려면 [List]를 선택한
다음  키를 누릅니다.

4. 목록 화면에서x 데이터 {2, 3, 4, 5}를 입력합니다.

2 3 4 5

5.  키를 누릅니다.
• Binomial CD 매개변수 입력 화면이 표시됩니다.

6. 매개변수에 한 값을 입력합니다(N = 5, p = 0.5).

5 0 5

• 데이터 입력이 필요한 매개변수는 이 절차의 2단계에서 선택한 계산 종
류에 따라 다릅니다. 자세한 내용은 “매개변수 목록” (83페이지)을 참
조하십시오.

7. 모든 변수에 한 값을 입력한 후 [Execute]를 선택한 후  키를 누릅니
다.
• 그러면 계산 결과 화면을 표시합니다.

• 3단계에서 [List]를 선택한 경우 목록 화면에 계산 결과(P열)가 나타납
니다. 자세한 내용은 “목록 화면” (84페이지)을 참조하십시오.
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• 계산 결과가 표시된 상태에서 목록 화면에서 편집 조작(“목록 화면 내
용 편집하기” (84페이지) 참조)을 수행하면 모든 계산 결과가 지워집
니다. 목록은 이 절차의 4단계(목록 화면 데이터 입력 완료)의 상태로
돌아갑니다.

• 입력 값이 허용 범위를 벗어나면 에러 메시지가 나타납니다. 해당 데이
터에 한 입력 값이 허용 범위를 벗어나면 계산 결과 화면의 P열에
“ERROR”가 표시됩니다.

• 계산 결과 화면이 표시된 상태에서  키를 누르면 매개변수 입력 화면
으로 돌아갑니다.

주의

• 위의 2단계에서 Normal PD, Normal CD 또는 Inverse Normal을 선택했다면 데이터(x)
입력 방식은 항상 “Variable”(단일 x-데이터 항목 입력)입니다. 이 때문에 3단계의 메뉴는
현재 표시되지 않습니다.

• 데이터(x) 입력 방식이 “Variable”인 경우 계산 결과는 Ans 메모리에 저장됩니다.
• 분포 계산 정확도는 최  6자리의 유효 자릿수입니다.

매개변수 목록
아래 목록은 매개변수 입력 화면에 나타나는 기호의 의미를 나타냅니다.

Binomial PD, Binomial CD
x … 데이터
N … 시도 횟수
p … 성공 확률(0 ≤ p ≤ 1)

Normal PD
x … 데이터
μ … 모평균
σ … 모표준 편차(σ > 0)

Normal CD
Lower … 최소 경계값
Upper … 최  경계값
μ … 모평균
σ … 모표준 편차(σ > 0)

Inverse Normal
Area … 확률값(0 ≤ Area ≤ 1)
μ … 모평균
σ … 모표준 편차(σ > 0)
(꼬리 설정은 항상 왼쪽입니다.)
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Poisson PD, Poisson CD
x … 데이터
λ … 평균

주의

• 각 매개변수 이름에 마지막으로 입력된 값은 입력되는 입력 화면과 상관없이 유지됩니
다. 예를 들어 Binomial PD 매개변수 입력 화면에서 N 값을 입력하면 Binomial CD 매개
변수 입력 화면에서도 N 값이 변경됩니다.

• 각 매개변수에 해 입력한 값은 다음 작업 중 하나를 실행하지 않는 한 유지됩니다:
 – [Reset] > [Settings & Data] 또는  – [Reset] > [Initialize All].

목록 화면
목록 화면을 사용하여 최  45개의 x-데이터 항목을 입력할 수 있습니다. 계
산 결과도 목록 화면에 표시됩니다.

(1) 분포 계산 종류
(2) 현재 커서 위치의 값
(3) 데이터(x)
(4) 계산 결과(P)

주의

• 목록 화면에서 셀의 값을 변수에 저장할 수 있습니다. 예를 들어 위의 화면이 표시된 상
태에서 다음 조작을 수행하면 변수 A에 1을 저장합니다:  – [A=] > [Store]. 변수에 
한 자세한 내용은 “변수(A, B, C, D, E, F, x, y, z)” (35페이지)를 참조하십시오.

• 아래 작업 중 하나를 수행하면 목록 화면에 입력된 모든 x-데이터가 삭제됩니다.
- HOME 화면으로 돌아가서 다른 계산기 앱 실행
- [Delete All] 실행(“모든 목록 화면 내용을 삭제하기” (85페이지) 참조)
-  – [Reset] > [Settings & Data] 또는  – [Reset] > [Initialize All] 실행

목록 화면 내용 편집하기

셀의 x 데이터를 변경하기

목록 화면에서 변경할 데이터가 포함된 셀로 커서를 이동하고 새로운 데이
터를 입력한 후  키를 누릅니다.
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행 삭제하기

목록 화면에서 삭제할 행으로 커서를 이동한 후  키를 누릅니다.

행 삽입하기

1. 목록 화면에서 삽입할 행의 아래가 될 행으로 커서를 이동합니다.
2. 다음과 같은 조작을 수행하십시오:  – [Edit] > [Insert Row].

• 초기 설정값으로 입력이 0인 행을 삽입합니다.

3. 데이터를 입력합니다.

모든 목록 화면 내용을 삭제하기

목록 화면에서 다음 조작을 수행합니다:  – [Edit] > [Delete All].

계산 예
x = 36, μ = 35, σ = 2일 때 정규 확률 밀도를 계산하기
1.  키를 누르고 Distribution 앱 아이콘을 선택한 다음  키를 누릅니다.
2. 표시되는 분포 계산 종류 메뉴에서 [Normal PD]를 선택한 후  키를 누
릅니다.
• 그러면 Normal PD 매개변수 입력 화면이 표시됩니다.

3. 매개변수에 한 값을 입력합니다(x = 36, μ = 35, σ = 2).

36 35 2

4.  키를 누릅니다.

•  키를 다시 누르거나  또는  키를 누르면 이 절차의 3단계의 매
개변수 입력 화면으로 돌아갑니다.

• 현재 표시된 계산 결과를 변수에 저장할 수 있습니다. 예를 들어 4단계
의 화면이 위에 표시된 상태에서 다음 조작을 수행하면 계산 결과를 변
수 A에 저장합니다:  – [A=] > [Store]. 변수에 한 자세한 내용은
“변수(A, B, C, D, E, F, x, y, z)” (35페이지)를 참조하십시오.
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스프레드시트 사용하기
Spreadsheet 앱을 사용하면 45행 × 5열(셀 A1~E45) 스프레드시트를 사용
하여 계산을 수행할 수 있습니다.
이 절의 조작을 수행하기 위해서는 먼저 Spreadsheet 앱을 실행하십시오.

 키를 누르고 Spreadsheet 앱 아이콘을 선택한 후  키를 누릅니다. 스
프레드시트 화면이 표시됩니다.

(1) 행 번호(1~45)
(2) 열 문자(A~E)
(3) 커서: 는 현재 선택된 셀을 나타냅니다. 현재 선택된 셀의 행 번호와
열 문자는 검은색으로 표시되고 다른 셀 행 번호와 열 문자는 짙은 회
색으로 표시됩니다.

(4) 편집 상자: 현재 커서가 있는 셀의 내용을 표시합니다.

중요!

• 계산기를 끄거나  키를 누를 때마다 스프레드시트에 한 모든 입력이 지워집니다.

셀 내용 입력 및 편집
각 셀에 상수 또는 수식을 입력할 수 있습니다.
상수: 상수는 입력을 완료하는 즉시 값이 고정되는 것입니다. 상수는 숫자
값이거나 앞에 등호(=)가 없는 계산 식(예: 7+3, sin30, A1×2 등)일 수 있습
니다.
수식: =A1×2와 같이 등호(=)로 시작하는 수식은 작성된 로 실행됩니다.

주의

• 편집 중인 셀(  키를 눌러 입력을 확인하기 전의 바이트 수)에는 최  49바이트를 입
력할 수 있습니다. 바이트 수를 계산하는 방법은 다음과 같습니다.
- 숫자, 변수, 기호: 문자당 1바이트
- 명령, 함수: 각 1바이트
각 전체 명령 또는 함수는 1바이트로 계산됩니다. 예를 들어 다음은 1바이트입니다:
“√ (”, “Sum(”.

• 각 셀에 입력된 내용에 따라 입력 확인 후 소모되는 바이트 수는 아래와 같습니다.
- 상수: 입력 자릿수에 관계없이 14바이트*
- 수식: 입력 바이트 수(최  49바이트) + 15바이트
* 유효자릿수 11자리 이상의 상수를 입력할 경우 입력이 확인되면 유효자릿수 10자리로
변환됩니다.
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예: 12345678915(11자리)를 입력하면 값은 1.234567892 x 1010(10자리)로 변환됩니
다.

남은 입력 용량을 표시하기

 키를 눌러서 [Available Memory]를 선택한 후  키를 누릅니다.

셀에 상수와 수식 입력하기
예 1: 셀 A1, A2, A3에 각각 상수 7×5, 7×6, A2+7을 입력합니다. 그런 다음
B1 셀에 다음 수식을 입력합니다: =A1+7.
1. 커서를 A1 셀로 이동합니다.
2. 아래의 키 조작을 수행합니다.

7 5 7 6 (A) 7

3. 커서를 B1 셀로 이동한 후 아래의 키 조작을 수행합니다.

(=) (A) 7

주의

• 스프레드시트 화면에서 셀의 값을 변수에 저장할 수 있습니다. 예를 들어 3단계의 화면
이 표시된 상태에서 다음 조작을 수행하면 42(B1 셀에 입력한 수식의 계산 결과)가 변수
A에 저장됩니다:  – [A=] > [Store]. 변수에 한 자세한 내용은 “변수(A, B, C, D,
E, F, x, y, z)” (35페이지)를 참조하십시오.

• 편집 상자의 수식을 그 로 표시할지 아니면 계산 결과 값으로 표시할지 지정할 수 있습
니다. “Spreadsheet 앱 설정 항목” (92페이지)을 참조하십시오.

기존 셀 데이터를 편집하기

1. 편집하고자 하는 내용이 있는 셀로 커서를 이동시킨 후  키를 누릅니
다.
•  키를 누르는 신 아래 조작을 수행할 수도 있습니다.

 – [Edit Cell]
• 편집 상자의 셀 내용이 오른쪽 맞춤에서 왼쪽 맞춤으로 변경됩니다. 내
용을 편집할 수 있도록 텍스트 커서(|)가 편집 상자에 나타납니다.

2.  및  키를 사용하여 셀 내용 주위로 텍스트 커서를 이동하고 필요에
따라 편집합니다.

3. 편집을 완료하고 적용하려면  키를 누릅니다.
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Grab 명령을 사용하여 셀 참조 이름을 입력하기

Grab 명령은 참조하고자 하는 셀을 선택하여 입력하기 위해 키 조작을 사용
하여 수동 참조 이름(예: A1) 입력 신 사용할 수 있습니다.

예 2: 예 1에서 계속하여 B2 셀에 다음 수식을 입력합니다: =A2+7.
1. 커서를 B2 셀로 이동합니다.
2. 아래의 조작을 수행합니다.

(=)  – [Spreadsheet] > [Grab]

7

셀 상  참조 및 절  참조
셀 참조에는 상  참조와 절  참조 등 두 가지 종류가 있습니다.

상  셀 참조

=A1+7과 같은 수식에서 셀 참조(A1)는 상  참조입니다. 즉, 수식이 있는
셀에 따라 변경됩니다. 예를 들어 수식 =A1+7이 원래 B1 셀에 있는 경우 C3
셀에 복사한 다음 붙여넣으면 =B3+7이 C3 셀에 입력됩니다. 복사 및 붙여
넣기 조작은 수식을 한 열(B에서 C로)과 두 행(1에서 3으로)으로 이동하므
로 수식의 A1 상  셀 참조가 B3으로 한 열과 두 행으로 이동합니다. 복사
및 붙여넣기 조작의 결과 상  셀 참조 이름이 스프레드시트 셀 범위를 벗어
나는 이름으로 변경되는 경우 해당 열 문자 및/또는 행 번호가 물음표(?)로
체되며, “ERROR”가 셀의 데이터로 표시됩니다.

절  셀 참조

행이나 열, 또는 셀 참조 이름의 행과 열 부분을 어디에 붙여넣든 동일하게
유지하려면 절  셀 참조 이름을 만들어야 합니다. 절  셀 참조를 만들려면
열 이름 및/또는 행 번호 앞에 달러 기호( )를 넣습니다. 세 가지 절  셀 참
조 중 하나를 사용할 수 있습니다: 상  행이 있는 절  열( A1), 절  행이
있는 상  열(A 1), 또는 절  행과 열( A 1).

절  셀 참조 기호( )를 입력하기

셀에 수식을 입력하는 동안  키를 누른 후 [Spreadsheet] > [ ]를 선택합
니다.
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스프레드시트 데이터를 잘라내기 및 붙여넣기

1. 잘라내고자 하는 내용이 있는 셀로 커서를 이동합니다.
2.  키를 눌러서 [Cut & Paste]를 선택한 후  키를 누릅니다.

• 그러면 붙여넣기 기 상태가 됩니다. 붙여넣기 기를 취소하려면 
또는  키를 누릅니다.

3. 방금 잘라낸 데이터를 붙여넣을 셀로 커서를 이동한 다음  키를 누릅
니다.
• 데이터를 붙여넣는 것과 동시에 잘라내기 조작을 수행한 셀의 데이터
가 삭제되고, 붙여넣기 기가 자동으로 취소됩니다.

주의

• 잘라내기 및 붙여넣기 조작의 경우 셀 참조는 상  또는 절  여부에 관계없이 붙여넣을
때 변경되지 않습니다.

스프레드시트 데이터를 복사 및 붙여넣기

1. 복사하고자 하는 내용이 있는 셀로 커서를 이동합니다.
2.  키를 눌러서 [Copy & Paste]를 선택한 후  키를 누릅니다.

• 그러면 붙여넣기 기 상태가 됩니다. 붙여넣기 기를 취소하려면 
또는  키를 누릅니다.

3. 방금 복사한 데이터를 붙여넣을 셀로 커서를 이동한 다음  키를 누릅
니다.
• 원하는 경우 복사한 데이터를 다른 셀에 붙여넣을 수 있도록  또는

 키를 누를 때까지 붙여넣기 기가 활성화된 상태로 유지됩니다.

주의

• 상  참조가 있는 수식이 포함된 셀의 내용을 복사하면 내용을 붙여넣은 셀의 위치에 따
라 상  참조가 변경됩니다.

특정 셀에서 입력 데이터를 삭제하기

삭제하고자 하는 내용이 있는 셀로 커서를 이동시킨 후  키를 누릅니다.

스프레드시트의 모든 셀 내용을 삭제하기

 키를 눌러서 [Delete All]을 선택한 후  키를 누릅니다.

Spreadsheet 앱 특수 명령 사용하기
Spreadsheet 앱에서 수식 또는 상수 내에서 아래 명령을 사용할 수 있습니
다. 이 명령은  키를 누르고 [Spreadsheet]를 선택하면 나타나는 메뉴에
있습니다.
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Min(
지정된 셀 범위에 있는 값의 최소값을 반환합니다.
구문: Min(시작 셀:끝 셀)

Max(
지정된 셀 범위에 있는 값의 최 값을 반환합니다.
구문: Max(시작 셀:끝 셀)

Mean(
지정된 셀 범위에 있는 값의 평균을 반환합니다.
구문: Mean(시작 셀:끝 셀)

Sum(
지정된 셀 범위에 있는 값의 합계를 반환합니다.
구문: Sum(시작 셀:끝 셀)

예 3: 예 1에서 계속해서 A1, A2, A3 셀의 합을 계산하는 수식 =Sum(A1:A3)
을 A4 셀에 입력합니다.
1. 커서를 A4 셀로 이동합니다.
2. =Sum(A1:A3)을 입력합니다.

(=)  – [Spreadsheet] > [Sum]
(A)

 – [Spreadsheet] > [:]
(A)

3.  키를 누릅니다.

동일한 수식이나 상수를 여러 셀에 일괄 입력하기
이 절의 절차를 사용하여 특정 일련의 셀에 동일한 수식이나 상수를 입력할
수 있습니다. Fill Formula 명령을 사용하여 수식을 일괄 입력하거나 Fill
Value를 사용하여 상수를 일괄 입력합니다.

주의

• 입력 수식 또는 상수에 상  참조가 포함된 경우 지정된 범위의 왼쪽 상단 셀에 따라 상
 참조가 입력됩니다. 입력 수식이나 상수에 절  참조가 포함된 경우 지정된 범위의
모든 셀에 절  참조가 입력됩니다.
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일련의 셀에 동일한 수식을 일괄 입력하기

예 4: 예 1에서 계속해서 B1, B2, B3 셀에 왼쪽 셀 값을 두 배로 한 다음 3을
빼는 수식을 일괄 입력합니다.
1. 커서를 B1 셀로 이동합니다.
2.  키를 눌러서 [Fill Formula]를 선택한 후  키를 누릅니다.

• 그러면 Fill Formula 화면이 표시됩니다.
3. “Form” 줄에 수식 =2A1-3을 입력합니다: 2 (A) 3 .

• 시작 부분에 등호(=)를 입력할 필요는 없습니다.
4. “Range” 줄에서 B1:B3을 일괄 입력 범위로 지정합니다.

5. 입력을 적용하려면  키를 누릅니다.
• 그러면 셀 B1에 =2A1-3, 셀 B2에 =2A2-3, 셀 B3에 =2A3-3을 입력합니
다.

일련의 셀에 동일한 상수를 일괄 입력하기

예 5: 예 4에서 계속해서 C1, C2, C3 셀에 왼쪽에 있는 셀 값의 세 배인 값을
일괄 입력합니다.
1. 커서를 C1 셀로 이동합니다.
2.  키를 눌러서 [Fill Value]를 선택한 후  키를 누릅니다.

• 그러면 Fill Value 화면이 표시됩니다.
3. “Value” 줄에 상수 B1× 3을 입력합니다: (B) 3 .
4. “Range” 줄에서 C1:C3을 일괄 입력 범위로 지정합니다.

5. 입력을 적용하려면  키를 누릅니다.
• 그러면 각 계산 결과의 값이 셀 C1, C2, C3에 입력됩니다.
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Spreadsheet 앱 설정 항목
TOOLS 메뉴에는 아래의 설정 항목이 포함되어 있습니다.
“◆”는 초기 설정을 나타냅니다.

Auto Calc
수식이 자동으로 다시 계산되어야 하는지 여부를 지정합니다.
On◆: 자동 재개산을 활성화합니다.
Off: 자동 재개산을 비활성화합니다.

Show Cell
편집 상자의 수식을 그 로 표시할지 아니면 계산 결과 값으로 표시할지 지
정하니다.
Formula◆: 수식을 있는 그 로 표시합니다.
Value: 수식의 계산 결과 값을 표시합니다.

Auto Calc 및 Recalculate
“Auto Calc”는 TOOLS 메뉴의 설정 항목입니다(“Spreadsheet 앱 설정 항
목” (92페이지) 참조).
Spreadsheet 앱의 초기 설정(Auto Calc: On)을 사용하면 셀 내용을 편집할
때마다 셀의 수식이 자동으로 다시 계산됩니다. 스프레드시트의 내용에 따
라 자동 재계산을 완료하는 데 시간이 오래 걸릴 수 있습니다. Auto Calc가
비활성화되면(Off) 필요에 따라 수동으로 재계산을 실행해야 합니다.

수동으로 재계산을 실행하기

 키를 누르고 [Recalculate]를 선택한 후  키를 누릅니다.

주의

• Auto Calc 설정이 On이라 하더라도 아래의 경우에는 [Recalculate]를 실행해야 합니다.
- SETTINGS 메뉴를 사용하여 Angle Unit 설정을 변경하는 경우
- 함수 “f(” 또는 “g(”를 사용하는 수식이 셀에 포함되어 있고 해당 정의 방정식 (f(x) 또는

g(x))가 업데이트되는 경우
- 셀에 변수를 사용하는 수식이 포함되어 있고 해당 변수가 업데이트된 경우

수치표 생성하기
Table 앱을 사용하여 f(x) 및 g(x) 함수에 해 등록된 정의 방정식을 기반으
로 수치표를 생성할 수 있습니다.
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수치표 생성을 위한 일반 절차

예 : -1 ≤ x ≤ 1 범위에 해서 0.5 스텝의 증분으로 함수 f(x) = x2 + 1
2

 및

g(x) = x2 - 1
2
에 한 수치표 생성하기

1.  키를 누르고 Table 앱 아이콘을 선택한 후  키를 누릅니다.
• 그러면 수치표 화면이 표시됩니다.
• f(x) 및 g(x) 중 하나 또는 양쪽에 정의 방정식이 등록되어 있지 않고 커
서 선택 위치의 데이터가 비어 있는 경우 화면 하단에 정의 방정식이 등
록되지 않았다는 메시지가 나타납니다.

2. 두 함수에서 수치표를 생성하도록 설정을 구성합니다.
(1)  키를 누른 후 [Table Type] > [f(x)/g(x)]를 선택합니다.
(2)  키를 누릅니다.
• 설정에 한 정보는 “Table Type에 따른 수치표의 최  행 수” (94페
이지)를 참조하십시오.

3. f(x)에 한 정의 방정식을 등록합니다.

 – [Define f(x)/g(x)] > [Define f(x)]
1 2

(  키를 누르기 직전의 화면)

4. g(x)에 한 정의 방정식을 등록합니다.

 – [Define f(x)/g(x)] > [Define g(x)]
1 2

(  키를 누르기 직전의 화면)

• 를 사용하여 정의 표현식을 등록할 수도 있습니다. 자세한 정보는
“정의 방정식 등록” (94페이지)을 참조하십시오.

5. 수치표의 범위 설정을 구성합니다.

 – [Table Range]
((-))1 1 0 5

6.  키를 누릅니다.
• 그러면 수치표 화면에 결과가 표시됩니다.
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• 수치표 생성 조작은 변수 x의 내용이 변경되게 합니다.

주의

• 수치표 화면에서 셀의 값을 변수에 저장할 수 있습니다. 예를 들어 6단계의 화면이 위에
표시된 상태에서 다음 조작을 수행하면 변수 A에 -1이 저장됩니다:  – [A=] > [Store].
변수에 한 자세한 내용은 “변수(A, B, C, D, E, F, x, y, z)” (35페이지)를 참조하십시오.

Table Type에 따른 수치표의 최  행 수
f(x) 및 g(x) 모두, 또는 둘 중 하나에 한 열을 표시하도록 수치표 화면 설정
을 구성할 수 있습니다. 설정하려면 수치표 화면이 표시된 상태에서  –
[Table Type]을 누를 때 나타나는 메뉴를 사용합니다.

f(x)/g(x) ... f(x) 및 g(x) 열 모두 표시(초기 설정)
f(x) ... f(x) 열만 표시
g(x) ... g(x) 열만 표시
생성된 수치표의 최  행 수는 Table Type 설정에 따라 다릅니다. “f(x)” 또는
“g(x)” 설정에 해 최  45행이 지원되고, “f(x)/g(x)” 설정에 해 30행이 지
원됩니다.

정의 방정식 등록
f(x) 및 g(x)에 한 정의 방정식을 등록하는 데는 두 가지 방법이 있습니다.
• Table 앱 수치표 화면이 표시된 상태에서  키를 눌러 방정식 등록

 – [Define f(x)/g(x)] > [Define f(x)]
 – [Define f(x)/g(x)] > [Define g(x)]

• Table 앱 수치표 화면이 표시되는 동안, 또는 Distribution, Equation(Simul
Equation / Polynomial), Inequality, Base-N, Ratio, Math Box를 제외한 계
산기 앱을 사용하는 동안  키를 눌러 방정식 등록

 – [Define f(x)]
 – [Define g(x)]

정의 방정식을 등록하기 위해 위의 둘 중 어떤 조작을 하더라도 동일한 f(x)
또는 g(x) 방정식 등록 화면이 나타납니다.
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주의

• 를 사용한 조작에 한 자세한 내용은 “f(x) 및 g(x)에 한 정의 방정식 등록 및 사용
하기” (60페이지)을 참조하십시오.

수치표 화면 데이터 편집하기

행 삭제하기

1. 수치표 화면에서 삭제할 행으로 커서를 이동합니다.
2.  키를 누릅니다.

행 삽입하기

1. 수치표 화면에서 삽입할 행의 아래가 될 행으로 커서를 이동합니다.
2. 다음과 같은 조작을 수행하십시오:  – [Edit] > [Insert Row].

모든 수치표 화면 내용 삭제하기

수치표 화면에서 다음 조작을 수행합니다:  – [Edit] > [Delete All].

x열의 셀에 입력된 값을 변경하기

현재 강조 표시된 x셀의 값을 변경할 수 있습니다. x 값을 변경하면 동일한
행의 f(x) 및 g(x) 값이 그에 따라 업데이트됩니다.

다음을 사용하여 강조 표시된 x열 셀에 값을 입력하기: {위 셀의 값}
+/- {스텝 값}

현재 강조 표시된 x셀 위의 x셀에 값이 있는 경우  또는  키를 누르면
위 셀의 값에 스텝 값을 더한 값과 같은 값이 강조 표시된 셀에 자동으로 입
력됩니다. 따라서 또한  키를 누르면 위의 셀 값에서 스텝 값을 뺀 값과
동일한 값이 자동으로 입력됩니다. 동일한 행의 f(x) 및 g(x) 값도 그에 따라
업데이트됩니다.

f(x) 및 g(x) 업데이트 타이밍

수치표 화면에 표시되는 f(x) 및 g(x) 값은 다음 중 하나가 발생하면 업데이트
됩니다.
• Table Range 화면에서 [Execute]가 선택된 상태에서  키를 누른 경우.
• f(x) 및 g(x)에 한 정의 방정식이 업데이트되는 경우(정의 방정식이 합성
함수인 경우 제외).

• x열에 숫자가 입력된 경우(x열에서 , ,  키 누름 포함).

그러나 다음 조작 후에는 값이 자동으로 업데이트되지 않습니다.
• SETTINGS 메뉴를 사용하여 Angle Unit 설정을 변경하는 경우.
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• 변수(예: f(x) = 2x + A)를 포함하는 정의 방정식이 등록되었을 때 정의 방
정식의 변수가 업데이트(새 수치가 저장됨)되는 경우.

• 합성 함수의 정의 방정식(예: g(x) = f(x) × 2 - x)이 등록된 경우, 그리고 참
조 함수(예: g(x) = f(x) × 2 - x의 f(x))가 업데이트된 경우(새로운 정의 방정
식이 등록됨).
이 경우 수치표 화면이 표시된 상태에서  – [Recalculate]를 실행하여 값
을 업데이트합니다.

데이터 보존
다음을 수행하면 일부 데이터가 삭제되고 Table 앱의 일부 설정이 지워집니
다.
① HOME 화면으로 돌아가서 다른 계산기 앱 실행.
②  키 누르기.
③ SETTINGS 메뉴로 Input/Output 설정 변경.
④ TOOLS 메뉴로 Table Type 설정 변경.
아래 표는 어떤 데이터가 삭제되고 어떤 데이터가 유지되는지 보여줍니다.

연산

데이터, 설정
① ② ③ ④

수치표 데이터
(x-, f(x)-, g(x)-열) 삭제됨 삭제됨 삭제됨 삭제됨

Table Range 설정 삭제됨 유지됨 유지됨 유지됨

Table Type 설정 유지됨 유지됨 유지됨 --
f(x), g(x) 정의 방정식 유지됨 삭제됨 삭제됨 유지됨

방정식 계산
Equation 앱에는 아래에 설명된 세 가지 함수가 포함되어 있습니다. 앱을 시
작한 후, 나타나는 Equation 메뉴를 사용하여 원하는 함수를 선택할 수 있습
니다.

Simul Equation: 미지수가 2~4개인 연립 1차방정식
Polynomial: 2차~4차의 고차 방정식
Solver: 입력된 방정식에 포함된 모든 변수의 값을 찾는 함수
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연립 1차방정식
여기서는 미지수가 3개인 연립 1차방정식을 푸는 예를 들어 연립 방정식을
푸는 일반적인 절차를 설명합니다.

예 1: 

1.  키를 누르고 Equation 앱 아이콘을 선택한 다음  키를 누릅니다.
• 그러면 Equation 메뉴가 표시됩니다.

2. [Simul Equation]을 선택한 후  키를 누릅니다.
• 그러면 미지수 개수 메뉴가 표시됩니다.

3. [3 Unknowns]를 선택한 후  키를 누릅니다.
• 계수 편집기가 표시됩니다.

4. 계수 편집기를 사용해서 계수값을 입력합니다.

1 ((-))1 1 2
1 1 ((-))1 0

((-))1 1 1 4

• 계수 편집기가 표시되는 동안  키를 누르면 모든 계수가 0으로 지워
집니다.

5.  키를 누릅니다.
• 해가 표시됩니다.

•  인디케이터가 표시되는 동안 (또는 ) 키를 누를 때마다 다른 해
가 표시됩니다.
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 (또는 )

 (또는 )

•  인디케이터가 표시되는 동안  또는 를 누르면 이전에 표시된
해가 다시 나타납니다.

• 마지막 해가 표시되는 동안  키를 누르면 계수 편집기로 되돌아갑니
다. 해가 표시되고 있는 중에 계수 편집기로 되돌아가려면 를 눌러
주십시오.

• 계수 편집기가 표시되는 동안  키를 누르면 미지수 개수 메뉴로 돌아
갑니다.

주의

• 계수 편집기가 표시되는 동안 현재 강조 표시된 값을 변수에 저장할 수 있습니다. 또한
해가 표시되고 있는 동안 현재 표시된 해를 변수에 저장할 수 있습니다. 변수에 한 자
세한 내용은 “변수(A, B, C, D, E, F, x, y, z)” (35페이지)를 참조하십시오.

2차~4차의 고차 방정식
Equation 앱으로 고차 방정식을 풀면 방정식의 차수에 따라 아래 값이 표시
됩니다.

• 2차방정식
ax2+bx+c=0의 해가 표시된 후 y=ax2+bx+c에 한 최소(또는 최 ) 좌표
(x, y)가 표시됩니다.

• 3차방정식
ax3+bx2+cx+d=0의 해가 표시된 후 y=ax3+bx2+cx+d의 지역 최소(또는 지
역 최 )의 좌표(x, y)가 표시됩니다(지역 최소 또는 지역 최 가 존재할
경우에만). 지역 최소 또는 지역 최 가 존재하지 않는 경우 마지막 해가
표시되는 동안  키를 누르면 “No Local Max/Min” 메시지가 나타납니
다.

• 4차방정식
ax4+bx3+cx2+dx+e=0의 해가 표시됩니다.

여기서는 고차 방정식을 푸는 일반적인 절차를 설명하기 위해 2차 방정식의
예를 보여줍니다.

예 2: x2 + 2x − 2 = 0
(Input/Output: MathI/MathO)

98



1.  키를 누르고 Equation 앱 아이콘을 선택한 다음  키를 누릅니다.
• 그러면 Equation 메뉴가 표시됩니다.

2. [Polynomial]을 선택한 후  키를 누릅니다.
• 그러면 차수 메뉴가 표시됩니다.

3. [ax2+bx+c]를 선택한 후  키를 누릅니다.
• 계수 편집기가 표시됩니다.

4. 계수 편집기를 사용해서 계수값을 입력합니다.

1 2 ((-))2

• 계수 편집기가 표시되는 동안  키를 누르면 모든 계수가 0으로 지워
집니다.

5.  키를 누릅니다.
• 해가 표시됩니다.

•  인디케이터가 표시되는 동안 (또는 ) 키를 누를 때마다 다른 계
산 결과가 표시됩니다(해 또는 좌표).

 (또는 )

(y = x2 + 2x − 2의 최소값의 x-좌표를 표시합니다.)

 (또는 )
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(y = x2 + 2x − 2의 최소값의 y-좌표를 표시합니다.)

 (또는 )

•  인디케이터가 표시되는 동안  또는 를 누르면 이전에 표시된
계산 결과가 다시 나타납니다.

• 마지막 계산 결과가 표시되는 동안  키를 누르면 계수 편집기로 되돌
아갑니다. 계산 결과가 표시되고 있는 중에 계수 편집기로 되돌아가려
면 를 눌러 주십시오.

• 계수 편집기가 표시되는 동안  키를 누르면 차수 메뉴로 돌아갑니다.

주의

• 계수 편집기가 표시되는 동안 현재 강조 표시된 값을 변수에 저장할 수 있습니다. 또한
계산 결과(해 또는 좌표)가 표시되는 동안 변수에 저장할 수 있습니다. 변수에 한 자세
한 내용은 “변수(A, B, C, D, E, F, x, y, z)” (35페이지)를 참조하십시오.

복소수 해 표시(Complex Roots)

고차 방정식은 복소수의 해를 가질 수 있습니다. Equation 메뉴에서
Polynomial을 선택하면 아래 조작을 사용하여 복소수의 해 표시를 활성화
하거나 비활성화할 수 있습니다.

 – [Complex Roots] > [On] 
복소수의 해 표시를 활성화합니다(초기 설정).

 – [Complex Roots] > [Off] 
복소수의 해 표시를 비활성화합니다. 하나 이상의 복소수 해만 있는 방
정식을 입력하고 실행하면 “No Real Roots” 메시지가 나타납니다.

예 3: 2x2 + 3x + 4 = 0
(Input/Output: MathI/MathO, Complex Result: a+bi, Complex Roots: On)
1.  키를 누르고 Equation 앱 아이콘을 선택한 다음  키를 누릅니다.

• 그러면 Equation 메뉴가 표시됩니다.

2. [Polynomial] > [ax2+bx+c]를 선택합니다.
• 계수 편집기가 표시됩니다.

100



3. 계수 편집기를 사용해서 계수값을 입력합니다.

2 3 4

4.  키를 누릅니다.
• 해가 표시됩니다.

5. 다른 해와 좌표 값을 표시합니다.

 (또는 )

 (또는 )

 (또는 )

• 마지막 계산 결과가 표시되는 동안  키를 누르면 계수 편집기로 되돌
아갑니다. 계산 결과가 표시되고 있는 중에 계수 편집기로 되돌아가려
면 를 눌러 주십시오.

복소수의 해를 직교좌표 또는 극좌표로 변환하기

 키를 누를 때 나타나는 FORMAT 메뉴를 이용하여 복소수 해를 직교좌
표 또는 극좌표 형식으로 변환할 수 있습니다.

예 4: 예 3 (100페이지)에 표시된 복소수 해를 극좌표 형식으로 변환한 다음
직교 좌표 형식으로 변환하기
1. 예 3 (100페이지)의 1~4단계를 수행합니다.
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2.  키를 누르고 [Polar Coord]를 선택한 후  키를 누릅니다.
• 그러면 해를 극좌표 형식으로 변환합니다.

3.  키를 눌러서 [Rectangular Coord]를 선택한 후  키를 누릅니다.
• 그러면 해를 직교좌표 형식으로 변환합니다.

Solver 사용하기
Solver는 방정식의 근사 해법으로 뉴턴의 방법을 사용합니다. Solver는 다
음 형식의 방정식 입력을 지원합니다.
예: y = x + 5, x = sin(A), xy + C (xy + C = 0으로 취급)

예 5: B = 4일 때 x2 - B
2

 = 0의 x 구하기

(Input/Output: MathI/MathO)

주의

• x2 - B
2

 = 0의 x를 풀기 전에 변수 B에 4를 저장해야 합니다. 이것은 아래 절차의 3단계

에서 수행됩니다.

1.  키를 누르고 Equation 앱 아이콘을 선택한 다음  키를 누릅니다.
• 그러면 Equation 메뉴가 표시됩니다.

2. [Solver]를 선택한 후  키를 누릅니다.
• 그러면 Solver 방정식 입력 화면이 표시됩니다.

3. 여기서 변수 B에 4를 저장합니다.

4

• 이 조작은 이 절차의 7단계 이전의 어느 시점에서든 실행할 수 있습니
다.

• 변수에 한 자세한 내용은 “변수(A, B, C, D, E, F, x, y, z)” (35페이지)
를 참조하십시오.

•  키를 눌러서 Solver 방정식 입력 화면으로 되돌아갑니다.
4. 방정식을 입력합니다.
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(B) 2
(=)*0

* 다음 조작을 사용하여 = 기호를 입력할 수도 있습니다:  – [Equation]
> [=].

5. 입력 방정식을 등록하려면  키를 누릅니다.
6. Solve Target 화면이 나타나면 [x]가 선택되었는지 확인한 후  키를 누
릅니다.
• 그러면 x의 초기값이 있는 화면을 표시합니다.

7. x의 초기값으로 1을 입력합니다.

1

8. [Execute]가 선택되었는지 확인한 후  키를 눌러 방정식을 풉니다.

(1) 구하고자 하는 변수
(2) 해
(3) (좌측)-(우측) 결과

• 해는 항상 소수점 포맷으로 표시됩니다.
• (좌측)-(우측) 결과가 0에 가까울수록 해의 정확도가 높아집니다.

9. 그런 다음 원하는 조작을 수행하는 키를 누릅니다.

수행 방법: 누를 키:

6단계의 화면으로 돌아갑니다. *

입력 표현식을 저장하고 4단계의 화면으로 돌
아갑니다.

 또는 

* 이 키를 눌렀을 때의 초기값은 계산에 마지막으로 사용한 초기값이 됩
니다.
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중요!

• Solver는 사전 설정된 횟수만큼 수렴을 실행합니다. 해를
찾을 수 없는 경우에는 근처에 있는 것과 같은 확인 화
면을 표시하여 계속할지 묻습니다. [Continue]가 선택된
상태에서  키를 누르고 계속하거나 [Exit]를 선택한
다음  키를 눌러서 Solver 조작을 취소합니다.

• 해의 변수(위의 예에서 x)의 초기값에 입력한 내용에 따라 Solver가 해를 얻지 못할 수
있습니다. 이런 경우에는 해에 가까운 것으로 초기값을 변경해 보십시오.

• Solver는 해가 존재하더라도 올바른 해를 결정할 수 없는 경우가 있습니다.
• Solver는 뉴턴의 방법을 사용하기 때문에 복수해가 있더라도 그 중에서 하나만 제시합
니다.

• 뉴턴의 방법에는 한계가 있기 때문에 다음과 같은 방정식에 한 답은 구하기 어려운 경
향이 있습니다: y=sinx, y=ex, y=√x.

부등식 계산
Inequality 앱을 사용하여 2차, 3차, 4차 부등식을 풀 수 있습니다.

부등식 계산을 수행하기 위한 일반 절차
예 1: x2 + 2x - 3 ≥ 0 풀기
1.  키를 누르고 Inequality 앱 아이콘을 선택한 다음  키를 누릅니다.

• 그러면 차수 메뉴가 표시됩니다.

2. [ax2+bx+c]를 선택한 후  키를 누릅니다.

3. 표시되는 메뉴에서 부등식 기호 타입과 방향을 선택하십시오(>, <, ≥, ≤).
• 여기서 x2 + 2x - 3 ≥ 0을 풀고, [ax2+bx+c≥0]을 선택한 후  키를 누릅
니다.

4. 표시되는 계수 편집기에서 계수값을 입력합니다.

1 2 ((-))3

5.  키를 누릅니다.
• 그러면 해가 표시됩니다.
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• 해가 표시되고 있는 중에 계수 편집기로 되돌아가려면 , , 또는 
키를 누릅니다.

• 계수 편집기가 표시되는 동안  키를 누르면 2단계의 메뉴로 돌아갑
니다.

• 2단계의 메뉴가 표시되는 동안  키를 누르면 차수 메뉴로 돌아갑니
다.

주의

• SETTINGS 메뉴의 Input/Output 설정에서 MathI/MathO 이외의 항목을 선택하면 아래
화면과 같이 해가 표시됩니다.

• 부등식에 한 해가 없을 때는 해 화면에 “No Solution”이 표시됩니다(예: x2 < 0).
• 부등식의 해가 모두 숫자일 때 “All Real Numbers”가 해 화면에 나타납니다(예: x2 ≥ 0).

복소수 계산
복소수 계산을 수행하려면 먼저 Complex 앱을 실행하십시오.

 키를 누르고 Complex 앱 아이콘을 선택한 후  키를 누릅니다.

복소수 입력하기
직교좌표(a+bi) 또는 극좌표(r∠θ) 중 하나를 사용해서 복소수를 입력할 수
있습니다.

예 1: 2+3i 입력하기

2 3 (i)*

* 다음 조작을 사용하여 i를 입력할 수도 있습니다:  – [Complex] > [i].

예 2: 5∠30 입력하기

5  – [Complex] > [∠] 30
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Complex 앱 계산 예

예의 조작을 수행하기 전에

• 이 절의 예에서는 SETTINGS 메뉴를 사용하여 Input/Output 설정에 해
MathI/MathO를 선택합니다. 각 예에 표시된 로 다른 설정을 구성합니
다.

• 복소수 계산 결과는 SETTINGS 메뉴에서 설정된 Complex Result에 따라
표시됩니다.

• 극좌표 형식으로 계산 결과를 입력하고 표시하려는 경우에는 계산을 시
작하기 전에 SETTINGS 메뉴의 Angle Unit을 지정해 주십시오.

• 계산 결과의 θ 값은 -180° < θ ≤ 180° 범위에서 표시됩니다.
• MathI/MathO 이외의 것을 선택했을 때 계산 결과 표시는 a와 bi(또는 r과

θ)를 별도의 행에 보여줍니다.

예 3: (1 + i)4 + (1 - i)2 = -4 - 2i
(Complex Result: a+bi)

1 (i) 4
1 (i)

주의

• (a+bi)n 구문을 사용하여 복소수를 정수 누승으로 올릴 때 누승 값은 다음 범위 내에 있
을 수 있습니다: -1 × 1010 < n < 1 × 1010.

예 4: 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2  – [Complex] > [∠] 45

예 5: √2 + √2i = 2∠45
(Angle Unit: Degree, Complex Result: r∠θ)

2 2 (i)

예 6: 2 + 3i의 켤레복소수 구하기
(Complex Result: a+bi)
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 – [Complex] > [Conjugate]
2 3 (i)

예 7: 1 + i의 절 값과 인수 구하기
(Angle Unit: Degree)

 – [Numeric Calc] > [Absolute Value]
1 (i)

 – [Complex] > [Argument]
1 (i)

예 8: 2 + 3i의 실수부와 허수부 추출하기

 – [Complex] > [Real Part]
2 3 (i)

 – [Complex] > [Imaginary Part]
2 3 (i)

복소수 계산 결과를 직교좌표 또는 극좌표로 변환하기

 키를 누를 때 나타나는 FORMAT 메뉴를 이용하여 복소수 계산 결과를
직교좌표 또는 극좌표 형식으로 변환할 수 있습니다.

예 9: √2 + √2i = 2∠45, 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2 2 (i)

 – [Polar Coord]

 – [Rectangular Coord]
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n진 계산
10진수, 16진수, 2진수 및/또는 8진수 값을 사용하여 계산을 수행하려면
Base-N 앱을 실행하십시오.  키를 누르고 Base-N 앱 아이콘을 선택한 후

 키를 누릅니다. Base-N 앱을 실행할 때 초기 번호 모드 설정은 10진수입
니다.

Base-N 앱을 실행한 후  키를 사용하여 번호 모드를 전환합니다.
 키를 누를 때마다 아래와 같이 번호 모드가 순환됩니다.

(1) [Decimal]  (2) [Hexadecimal]  (3) [Binary]  (4) [Octal]

주의

• 예에 표시된 값에 추가된 아래 첨자는 각 값의 진수(번호 모드)을 나타냅니다.
예: 12 ... 2진수 1; 116 ... 16진수 1

예 1: 112 + 12 계산하기
1.  키를 사용하여 번호 모드를 [Binary]로 변경합니다.
2. 112 + 12 계산을 수행합니다.

11 1

예 2: 16진수로 1F16 + 116 계산하기
1.  키를 사용하여 번호 모드를 [Hexadecimal]로 변경합니다.
2. 1F 16 + 116 계산을 수행합니다.

1 (F) 1

주의

• 다음과 같은 키를 사용해서 16진수에 해서 A에서 F까지 문자를 입력합니다: 
(A), (B), (C), (D), (E), (F). 아래 표시된 CATALOG
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메뉴 항목을 사용하여 16진수 값을 입력할 수도 있습니다.
 – [Hex Value] > [A], [B], [C], [D], [E], 또는 [F]

• 아래 조작을 사용하여 A부터 F까지의 어떤 문자를 입력하면 해당 문자는 16진수 값이
아닌 변수 이름으로 처리됩니다.
(1)  키를 눌러 변수 목록 화면을 표시합니다.
(2) [A=], [B=], [C=], [D=], [E=], 또는 [F=]를 선택한 후  키를 누릅니다.
(3) 나타나는 메뉴에서 [Recall]을 선택합니다.

• Base-N 앱에서는 분수(소수) 값 및 지수 입력이 지원되지 않습니다. 계산 결과에 분수
부분이 있는 경우에는 잘립니다.

• 입력 및 출력 범위(32비트)에 한 자세한 내용은 아래에 나와 있습니다.•

진수 범위

2진수

양수: 00000000000000000000000000000000 ≤ x ≤
01111111111111111111111111111111
음수: 10000000000000000000000000000000 ≤ x ≤
11111111111111111111111111111111

8진수
양수: 00000000000 ≤ x ≤ 17777777777
음수: 20000000000 ≤ x ≤ 37777777777

10진수 -2147483648 ≤ x ≤ 2147483647

16진수
양수: 00000000 ≤ x ≤ 7FFFFFFF
음수: 80000000 ≤ x ≤ FFFFFFFF

• Math ERROR는 계산 결과가 사용 중인 숫자 체계에 적용 가능한 범위를 벗어났을 때
발생합니다.

특수한 입력값의 번호 모드 지정하기
값의 바로 전에 특수한 명령을 입력해서 그 값의 번호 모드를 지정할 수 있
습니다. 특수한 명령에는 d(10진수), h(16진수), b(2진수) 및 o(8진수) 등이
있습니다.

예 3: 1010 + 1016 + 102 + 108을 계산해서 10진수 값으로 결과를 표시하려
면

1.  키를 사용하여 번호 모드를 [Decimal]로 변경합니다.
2. 1010 + 1016 + 102 + 108 계산을 수행합니다.

 – [Base Prefix] > [Decimal(d)] 10
 – [Base Prefix] > [Hexadecimal(h)] 10

 – [Base Prefix] > [Binary(b)] 10
 – [Base Prefix] > [Octal(o)] 10

다른 종류의 값으로 계산 결과 변환하기
 키를 사용해서 현재 표시된 계산 결과를 다른 종류의 값으로 변환할 수

있습니다.
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예 4: 10진수 모드에서 1510 × 3710을 계산한 후 결과를 16진수로 변환하기
1.  키를 사용하여 번호 모드를 [Decimal]로 변경합니다.
2. 1510 × 3710 계산을 수행합니다.

15 37

3.  키를 사용하여 번호 모드를 [Hexadecimal]로 변경합니다.

논리 및 부정 조작
논리 및 부정 조작은  키를 누르고 [Logic Operation]을 선택한 다음 나타
나는 메뉴에서 원하는 명령(Neg, Not, and, or, xor, xnor)을 선택하여 수행됩
니다. 아래의 모든 예는 2진수 모드에서 수행됩니다.

예 5: 10102 및 11002의 논리 AND 구하기(10102 and 11002)

1010
 – [Logic Operation] > [and]

1100

예 6: 10102의 비트 방향의 보수 구하기(Not(10102))

 – [Logic Operation] > [Not]
1010

주의

• 2진수, 8진수 또는 16진수값의 음수는 계산기가 값을 일단 그 2진수의 2의 보수로 만든
후에 원래의 진수로 되돌립니다. 10진수값의 경우 계산기는 단지 음의 부호를 추가할
뿐입니다.

행렬 계산
Matrix 앱을 사용해서 4×4까지의 행렬을 포함하는 계산을 수행합니다.

행렬 계산을 수행하기 위한 일반 절차
행렬 계산을 수행하려면 아래 예와 같이 특수 행렬 변수(MatA, MatB, MatC,
MatD)를 사용하십시오.
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예 1:  계산하기

• 곱셈(행렬 1 × 행렬 2)의 경우 행렬 1의 열 수가 행렬 2의 행 수와 일치해
야 합니다. 그렇지 않으면 에러가 발생합니다.

1.  키를 누르고 Matrix 앱 아이콘을 선택한 다음  키를 누릅니다.
• 그러면 행렬 계산 화면을 표시합니다.

2.  키를 누릅니다.
• 그러면 행렬 변수 목록 화면이 표시됩니다.

• 행렬 변수 목록 화면 내용과 행렬 변수 저장, 편집 또는 기타 조작을 수
행하는 방법에 한 자세한 내용은 “행렬 변수 목록 화면” (112페이지)
을 참조하십시오.

3. 를 MatA에 저장하려면 아래 단계를 수행하십시오.

(1) [MatA:]를 선택한 후  키를 누릅니다.
• 그러면 행렬 크기 설정 화면이 표시됩니다(초기 설정: 2행, 2열).

(2) 여기에 2×2 행렬을 저장하고자 하므로 [Confirm]을 선택하고  키를
누릅니다.
• 그러면 MatA에 해서 2 × 2 행렬의 요소를 입력하기 위한 행렬 편
집기를 표시합니다.

(3) MatA의 요소를 입력합니다.

2 1 1 1

(4) , , 또는  키를 눌러서 행렬 계산 화면으로 되돌아갑니다.
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4. 를 MatB에 저장하려면 아래 단계를 수행하십시오.

(1)  키를 누르고 [MatB:]를 선택한 후  키를 누릅니다.
(2) [Confirm]을 선택한 후  키를 누릅니다.
(3) MatB의 요소를 입력합니다.

2 ((-))1 ((-))1 2

(4) , , 또는  키를 눌러서 행렬 계산 화면으로 되돌아갑니다.
5. MatA×MatB를 입력합니다.

 – [Matrix] > [MatA]
 – [Matrix] > [MatB]

6.  키를 누릅니다.
• 그러면 계산 결과와 함께 MatAns(행렬 앤서 메모리) 화면이 표시합니
다.

• MatAns에 한 자세한 내용은 “행렬 응답 메모리(MatAns)” (115페이
지)를 참조하십시오.

• MatAns 화면이 표시된 상태에서  키를 누르면 행렬 계산 화면으로
돌아가 계산식을 지웁니다.  또는  키를 누르면 이 절차의 5단계에
서 계산식 입력 완료 상태로 돌아갑니다.

주의

• 행렬 편집기 또는 MatAns 화면이 표시되는 동안 현재 강조 표시된 값을 변수에 저장할
수 있습니다. 행렬 계산 화면이 표시되고 계산 결과 값이 화면에 있는 동안 표시된 계산
결과를 변수에 저장할 수 있습니다. 변수에 한 자세한 내용은 “변수(A, B, C, D, E, F,
x, y, z)” (35페이지)를 참조하십시오.

행렬 변수 목록 화면
행렬 변수 목록 화면은 행렬을 행렬 변수 MatA, MatB, MatC, MatD에 저장
하거나 이전에 저장된 행렬을 편집하려는 경우 사용해야 하는 입력 포털입
니다. 각 행렬 변수의 상태는 아래 예와 같이 표시됩니다.
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(1) 2×2
는 2×2 행렬이 행렬 변수에 저장됨을 나타냅니다.

(2) None
는 행렬 변수에 아무것도 저장되지 않음을 나타냅니다.

행렬 변수 목록 화면 표시하기

현재 표시된 화면에 따라 아래 조작 중 하나를 수행합니다.
• 행렬 계산 화면이 표시될 때:

 키를 누릅니다.
• 행렬 편집기 또는 MatAns 화면이 표시될 때:

 키를 눌러서 [Define Matrix]를 선택한 후  키를 누릅니다.

행렬 변수에 새로운 데이터 저장하기

예 2: 2×3 행렬  저장하기

1. 행렬 계산 화면이 표시된 상태에서  키를 눌러 행렬 변수 목록 화면을
표시합니다.

2. 새 데이터를 저장할 행렬 변수(MatA, MatB, MatC, MatD)를 선택한 후 
키를 누릅니다.
• 상태가 “None”인 행렬 변수를 선택한 경우 이 절차의 4단계로 진행합
니다.

• 이미 행렬이 저장되어 있는 행렬 변수를 선택하면 메뉴 화면이 나타납
니다. 3단계로 진행합니다.

3. [Define New]를 선택한 후  키를 누릅니다.
4. 표시되는 “Matrix Size?” 화면에서 행렬의 행과 열 수를 지정합니다.

• 2×3 행렬을 지정하려면 아래 단계를 수행하십시오.
(1) [Rows]를 선택한 후  키를 누릅니다. 나타나는 메뉴에서 [2 Rows]
를 선택한 후  키를 누릅니다.

(2) [Columns]를 선택한 후  키를 누릅니다. 나타나는 메뉴에서 [3
Columns]를 선택한 후  키를 누릅니다.

5. 행과 열을 원하는 로 지정했으면 [Confirm]을 선택하고  키를 누릅니
다.
• 그러면 계수 편집기가 표시됩니다.
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6. 행렬 변수의 요소를 입력합니다.

1 0 ((-))1
0 ((-))1 1

7. , , 또는  키를 눌러서 행렬 계산 화면으로 되돌아갑니다.

주의

•  키를 누르거나 계산기 앱을 변경하거나 계산기의 전원을 꺼도 행렬 변수 내용은 유
지됩니다. 아래 조작 중 하나를 실행하면 모든 행렬 변수의 내용이 지워집니다.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

행렬 변수 데이터 편집하기

1. 행렬 계산 화면이 표시된 상태에서  키를 눌러 행렬 변수 목록 화면을
표시합니다.

2. 편집하고자 하는 행렬 변수(MatA, MatB, MatC, MatD)를 선택한 후  키
를 누릅니다.

3. 나타나는 메뉴에서 [Edit]를 선택한 후  키를 누릅니다.
• 그러면 계수 편집기가 표시됩니다.

4. 행렬 편집기를 사용해서 행렬의 요소를 편집합니다.
• 변경하고자 하는 요소를 포함하는 셀로 커서를 이동시켜서 새로운 값
을 입력한 후 를 누릅니다.

5. , , 또는  키를 눌러서 행렬 계산 화면으로 되돌아갑니다.

행렬 변수(또는 MatAns) 내용 복사하기

1. 복사 소스로 사용하려는 행렬 변수의 행렬 편집기 또는 MatAns 화면을
표시합니다.
• 행렬 편집기를 표시하려면 “행렬 변수 데이터 편집하기” (114페이지)
의 1, 2, 3단계를 수행하십시오.

• MatAns 화면을 표시하려면 행렬 계산 화면이 표시된 상태에서 아래 단
계를 수행하십시오.

 – [Matrix] > [MatAns] 
2. 행렬 변수 복사 목적지를 선택합니다.

• 예를 들어 MatD에 복사하려면 다음 조작을 수행하십시오:  – [Store]
> [MatD].

• 그러면복사해 넣을 곳의 내용과 함께 행렬 편집기를 표시합니다.
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3. , , 또는  키를 눌러서 행렬 계산 화면으로 되돌아갑니다.

행렬 응답 메모리(MatAns)
Matrix 앱에서 실행한 계산 결과가 행렬일 때에는 항상 MatAns 화면이 결과
와 함께 표시됩니다. 결과는 “MatAns”라는 변수에도 저장됩니다.

MatAns 변수는 아래와 같은 계산에 이용할 수 있습니다.
• MatAns 변수를 계산에 삽입하려면 다음 조작을 수행하십시오:  –

[Matrix] > [MatAns].
• MatAns 화면이 표시되는 동안 다음 키 중 하나를 누르면 “MatAns”와 그
다음에 누른 키의 연산자 또는 함수가 표시되는 행렬 계산 화면으로 자동
전환됩니다: , , , , , , , ( ), ( ).

주의

•  키를 누르거나 계산기의 전원을 꺼도 MatAns 내용은 유지됩니다. 아래 조작 중 하
나를 수행하면 MatAns 내용이 지워집니다.
- HOME 화면으로 돌아가서 다른 계산기 앱 실행
-  – [Reset] > [Settings & Data] 실행하기
-  – [Reset] > [Initialize All] 실행하기

행렬 계산 예

아래 예에서는 MatA = , MatB = , MatC = , MatD =

를 사용합니다.

예 3: 두 행렬(MatA + MatB) 추가하기

 – [Matrix] > [MatA]
  – [Matrix] > [MatB] 

주의

• 더하거나 빼려면 두 행렬의 차원이 같아야 합니다. 차원이 다른 행렬을 더하거나 빼려고
하면 에러가 발생합니다.

예 4: MatA의 제곱 및 세제곱 구하기(MatA2, MatA3)

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Squared]
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 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Cubed]

예 5: MatA 반전하기(MatA-1)

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Inverse Matrix]

주의

• 정방 행렬(행과 열의 수가 동일)만 반전될 수 있습니다. 정방 행렬이 아닌 행렬을 반전하
려고 하면 에러가 발생합니다.

• 행렬식이 0인 행렬은 반전될 수 없습니다. 행렬식이 0인 행렬을 반전하려고 하면 에러
가 발생합니다.

• 계산 정밀도는 행렬식이 0에 가까운 행렬의 경우 영향을 받습니다.

예 6: MatA의 행렬식 구하기(Det(MatA))
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 – [Matrix] > [Matrix Calc] >
[Determinant]  – [Matrix] > [MatA]

주의

• 정방 행렬(행과 열의 수가 동일)에 해서만 행렬식을 얻을 수 있습니다. 정방 행렬이 아
닌 행렬의 행렬식을 구하려고 하면 에러가 발생합니다.

예 7: MatC의 전치 행렬 구하기(Trn(MatC))

 – [Matrix] > [Matrix Calc] >
[Transposition]  – [Matrix] > [MatC]

예 8: 2 × 2 단위 행렬을 만들어 MatA에 추가하기(Identity(2) + MatA)

 – [Matrix] > [Matrix Calc] > [Identity]
2   – [Matrix] > [MatA]

주의

• Identity 명령 인수(차원 수)로 1~4의 값을 지정할 수 있습니다.

예 9: MatC의 각 요소의 절 값 구하기(Abs(MatC))

 – [Numeric Calc] > [Absolute Value]
 – [Matrix] > [MatC]

벡터 계산
Vector 애을 사용해서 2차원 및 3차원 벡터 계산을 실행합니다.

벡터 계산을 수행하기 위한 일반 절차
벡터 계산을 수행하려면 아래 예와 같이 특수 벡터 변수(VctA, VctB, VctC,
VctD)를 사용하십시오.

예 1: (1, 2) + (3, 4) 계산하기
• 두 벡터의 덧셈이나 뺄셈을 수행할 때 두 벡터의 차원이 같아야 합니다.

1.  키를 누르고 Vector 앱 아이콘을 선택한 후  키를 누릅니다.
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• 그러면 벡터 계산 화면을 표시합니다.

2.  키를 누릅니다.
• 그러면 벡터 변수 목록 화면이 표시됩니다.

• 벡터 변수 목록 화면 내용과 벡터 변수 저장, 편집 또는 기타 조작을 수
행하는 방법에 한 자세한 내용은 “벡터 변수 목록 화면” (119페이지)
을 참조하십시오.

3. (1, 2)를 VctA에 저장하려면 아래 단계를 수행하십시오.
(1) [VctA:]를 선택한 후  키를 누릅니다.

• 그러면 벡터차원 설정 화면이 표시됩니다(초기 설정: 2차원).

(2) 여기에 2차원 벡터를 저장하고자 하므로 [Confirm]을 선택하고  키
를 누릅니다.

• 그러면 VctA에 해 2차원 벡터를 입력하기 위한 벡터 편집기를
표시합니다.

(3) VctA의 요소를 입력합니다.

1 2

(4) , , 또는  키를 눌러서 벡터 계산 화면으로 되돌아갑니다.
4. (3, 4)를 VctB에 저장하려면 아래 단계를 수행하십시오.

(1)  키를 누르고 [VctB:]를 선택한 후  키를 누릅니다.
(2) [Confirm]을 선택한 후  키를 누릅니다.
(3) VctB의 요소를 입력합니다.
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3 4

(4) , , 또는  키를 눌러서 벡터 계산 화면으로 되돌아갑니다.
5. VctA+VctB를 입력합니다.

 – [Vector] > [VctA]
 – [Vector] > [VctB]

6.  키를 누릅니다.
• 이것은 계산 결과를 VctAns (벡터 앤서 메모리) 화면에 표시합니다.

• VctAns에 한 자세한 내용은 “벡터 응답 메모리(VctAns)” (121페이
지)를 참조하십시오.

• VctAns 화면이 표시된 상태에서  키를 누르면 벡터 계산 화면으로
돌아가 계산식을 지웁니다.  또는  키를 누르면 이 절차의 5단계에
서 계산식 입력 완료 상태로 돌아갑니다.

주의

• 벡터 편집기 또는 VctAns 화면이 표시되는 동안 현재 강조 표시된 값을 변수에 저장할
수 있습니다. 벡터 계산 화면이 표시되고 계산 결과 값이 화면에 있는 동안 표시된 계산
결과를 변수에 저장할 수 있습니다. 변수에 한 자세한 내용은 “변수(A, B, C, D, E, F,
x, y, z)” (35페이지)를 참조하십시오.

벡터 변수 목록 화면
벡터 변수 목록 화면은 벡터를 벡터 변수 VctA, VctB, VctC, VctD에 저장하
거나 이전에 저장된 벡터 편집하려는 경우 사용해야 하는 입력 포털입니다.
각 벡터 변수의 상태는 아래 예와 같이 표시됩니다.

(1) 2
는 2차원 벡터가 벡터 변수에 저장됨을 나타냅니다.

(2) None
는 벡터 변수에 아무것도 저장되지 않음을 나타냅니다.
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벡터 변수 목록 화면 표시하기

현재 표시된 화면에 따라 아래 조작 중 하나를 수행합니다.
• 벡터 계산 화면이 표시될 때:

 키를 누릅니다.
• 벡터 편집기 또는 VctAns 화면이 표시될 때:

 키를 눌러서 [Define Vector]를 선택한 후  키를 누릅니다.

벡터 변수에 새로운 데이터 저장하기

예 2: 3차원 벡터(1, 2, 3)를 저장하기
1. 벡터 계산 화면이 표시된 상태에서  키를 눌러 벡터 변수 목록 화면을
표시합니다.

2. 새 데이터를 저장할 벡터 변수(VctA, VctB, VctC, VctD)를 선택한 후 
키를 누릅니다.
• 상태가 “None”인 벡터 변수를 선택한 경우 이 절차의 4단계로 진행합
니다.

• 이미 벡터이 저장되어 있는 벡터 변수를 선택하면 메뉴 화면이 나타납
니다. 3단계로 진행합니다.

3. [Define New]를 선택한 후  키를 누릅니다.
4. 표시되는 “Vector Dimension?” 화면에서 벡터 차원을 지정합니다.

• 3차원을 지정하려면 아래 단계를 수행합니다.
(1) [Dimensions]를 선택한 후  키를 누릅니다.
(2) 나타나는 메뉴에서 [3 Dimensions]를 선택한 후  키를 누릅니다.

5. 원하는 로 차원을 지정한 후 [Confirm]을 선택하고  키를 누릅니다.
• 그러면 벡터 편집기가 표시됩니다.

6. 벡터 변수의 요소를 입력합니다.

1 2 3
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7. , , 또는  키를 눌러서 벡터 계산 화면으로 되돌아갑니다.

주의

•  키를 누르거나 계산기 앱을 변경하거나 계산기의 전원을 꺼도 벡터 변수 내용은 유
지됩니다. 아래 조작 중 하나를 실행하면 모든 벡터 변수의 내용이 지워집니다.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

벡터 변수 데이터 편집하기

1. 벡터 계산 화면이 표시된 상태에서  키를 눌러 벡터 변수 목록 화면을
표시합니다.

2. 편집하고자 하는 벡터 변수(VctA, VctB, VctC, VctD)를 선택한 후  키
를 누릅니다.

3. 나타나는 메뉴에서 [Edit]를 선택한 후  키를 누릅니다.
• 그러면 벡터 편집기가 표시됩니다.

4. 벡터 편집기를 사용해서 벡터의 요소를 편집합니다.
• 변경하고자 하는 요소를 포함하는 셀로 커서를 이동시켜서 새로운 값
을 입력한 후 를 누릅니다.

5. , , 또는  키를 눌러서 벡터 계산 화면으로 되돌아갑니다.

벡터 변수(또는 VctAns) 내용을 복사하기

1. 복사 소스로 사용하려는 벡터 변수의 벡터 편집기 또는 VctAns 화면을 표
시합니다.
• 벡터 편집기를 표시하려면 “벡터 변수 데이터 편집하기” (121페이지)
의 1, 2, 3단계를 수행하십시오.

• VctAns 화면을 표시하려면 벡터 계산 화면이 표시된 상태에서 아래 단
계를 수행하십시오.

 – [Vector] > [VctAns] 
2. 벡터 변수 복사 목적지를 선택합니다.

• 예를 들어 VctD에 복사하려면 다음 조작을 수행하십시오:  – [Store]
> [VctD].

• 그러면복사해 넣을 곳의 내용과 함께 벡터 편집기를 표시합니다.
3. , , 또는  키를 눌러서 벡터 계산 화면으로 되돌아갑니다.

벡터 응답 메모리(VctAns)
Vector 앱에서 실행한 계산 결과가 벡터일 때에는 항상 결과와 함께 VctAns
화면이 표시됩니다. 결과는 “VctAns”라는 변수에도 저장됩니다.

VctAns 변수는 아래와 같은 계산에 이용할 수 있습니다.
• VctAns 변수를 계산에 삽입하려면 다음 조작을 수행하십시오:  –

[Vector] > [VctAns].
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• VctAns 화면이 표시되는 동안 다음 키 중 하나를 누르면 “VctAns”와 그 다
음에 누른 키의 연산자 또는 함수가 표시되는 벡터 계산 화면으로 자동 전
환됩니다: , , , , , , , ( ), ( ).

주의

•  키를 누르거나 계산기의 전원을 꺼도 VctAns 내용은 유지됩니다. 아래 조작 중 하나
를 수행하면 VctAns 내용이 지워집니다.
- HOME 화면으로 돌아가서 다른 계산기 앱 실행
-  – [Reset] > [Settings & Data] 실행하기
-  – [Reset] > [Initialize All] 실행하기

백터 계산 예
다음 예는 VctA = (1, 2), VctB = (3, 4) 및 VctC = (2, -1, 2)를 사용합니다.

예 3: VctA • VctB(벡터 내적)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Dot Product]

 – [Vector] > [VctB]

주의

• 내적을 계산할 때 두 벡터의 차원은 같아야 합니다.

예 4: VctA × VctB(벡터 외적)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Cross Product]

 – [Vector] > [VctB]

주의

• 외적을 계산할 때 두 벡터의 차원은 같아야 합니다.

예 5: VctA 및 VctB에 의해서 만들어진 각도를 소수 세 자리까지 구하기.
(Number Format: Fix 3, Angle Unit: Degree)
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 – [Vector] > [Vector Calc] > [Angle]
 – [Vector] > [VctA]

(,)  – [Vector] > [VctB]

주의

• 두 벡터에 의해 만들어진 각도를 계산할 때 두 벡터의 차원은 같아야 합니다.

예 6: VctB를 정규화하기

 – [Vector] > [Vector Calc] > [Unit Vector]
 – [Vector] > [VctB]

예 7: VctC의 절 값 구하기

 – [Numeric Calc] > [Absolute Value]
 – [Vector] > [VctC]

비율 계산
Ratio 앱을 사용하면 A, B, C, D의 값을 알고 있는 경우 비율식 A: B = X : D
(또는 A : B = C : X) 에서 X 값을 결정할 수 있습니다.

비율 계산을 수행하기 위한 일반 절차
예 1: 3 : 8 = X : 12에서 X 구하기
1.  키를 누르고 Ratio 앱 아이콘을 선택한 다음  키를 누릅니다.
2. 표시되는 메뉴에서 [A:B=X:D] 또는 [A:B=C:X]를 선택합니다.

• 여기서 3 : 8 = X : 12의 X를 구하고 [A:B=X:D]를 선택한 후  키를 누
릅니다.

3. 표시되는 계수 편집기에서 계수값을 입력합니다.
• 여기서 계수에 해 다음을 입력합니다: A = 3, B = 8, D = 12.

3 8 12

4. 모든 값이 원하는 로 된 후에  키를 누릅니다.
• 그러면 해(X값)가 표시됩니다.
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• , , 또는  키를 누르면 계수 편집기로 돌아갑니다.

주의

• 계수에 해 0을 입력하여 계산을 수행하면 Math ERROR 발생합니다.
• 아래 단계를 수행하면 모든 계수 편집기의 계수가 1로 리셋됩니다.

- 계수 편집기가 표시된 상태에서 , , , 또는  키를 누릅니다.
- 해가 표시된 상태에서  또는  키를 누릅니다.

• 현재 표시된 계산 결과를 변수에 저장할 수 있습니다. 예를 들어 4단계의 화면이 위에
표시된 상태에서 다음 조작을 수행하면 계산 결과를 변수 A에 저장합니다:  – [A=] >
[Store]. 변수에 한 자세한 내용은 “변수(A, B, C, D, E, F, x, y, z)” (35페이지)를 참조
하십시오.

비율식 종류 변경하기

1. 계수 편집기가 표시된 상태에서  키를 누릅니다.
2. 표시되는 메뉴에서 원하는 비율식 종류를 선택합니다.

계산 예
예 2: 1 : 2 = X : 10의 비율에서 X 계산하기

 – [Ratio] > [A:B=X:D]
1 2 10

Math Box 사용하기
Math Box 앱에는 다음과 같은 학습 지원 기능이 있습니다.
Dice Roll: Dice Roll은 주사위 확률을 시뮬레이션하는 기능입니다.
Coin Toss: Coin Toss는 동전 던지기 확률을 시뮬레이션하는 기능입니다.

Dice Roll
Dice Roll은 지정된 횟수만큼 가상 주사위를 1개, 2개, 또는 3개 굴리는 시뮬
레이션을 수행합니다. 결과에 해 다음 화면 중 하나를 선택할 수 있습니
다.
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List 화면

Relative Freq 화면

Dice Roll 일반 조작 절차

예: 주사위 2개의 100회 던지기를 시뮬레이션하기. 이 예의 경우 Relative
Freq 화면은 시뮬레이션 결과에 사용되며, 각 던지기에서 두 주사위 사이의
숫자 차이(0, 1, 2, 3, 4, 5)의 발생 횟수(도수)와 상  도수를 보여줍니다.

1.  키를 누르고 Math Box 앱 아이콘을 선택한 후  키를 누릅니다.
• 그러면 Math Box 메뉴가 표시됩니다.

2. [Dice Roll]을 선택한 후  키를 누릅니다.
• 그러면 매개변수 입력 화면을 표시합니다.

Dice: 주사위의 수를 1, 2, 또는 3으로 선택합니다.
Attempts: 주사위 던지기 횟수(시도 횟수)를 1~250의 값으로 입력합니다.
Same Result: 이 설정은 일반적으로 Off(초기 설정)입니다. 자세한 내용
은 “Same Result 설정” (128페이지)을 참조하십시오.

3. 각 메뉴 설정을 선택하고 원하는 방식으로 구성합니다.
(1) [Dice]를 선택한 후  키를 누릅니다. 나타나는 메뉴에서 [2 Dice]를
선택한 후  키를 누릅니다.

(2) [Attempts]를 선택한 후  키를 누릅니다. 나타나는 입력 화면에서
100을 입력하고  키를 누릅니다. [Confirm]을 선택한 후  키를 누
릅니다.

(3) [Same Result]를 Off(초기 설정)로 설정한 상태로 둡니다.
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4. 모든 설정이 원하는 로 되었으면 [Execute]를 선택하고  키를 누릅니
다.
• 시뮬레이션을 실행한 화면이 나타나며, 그 화면이 Result Type 메뉴로
변경됩니다.

List: 각 던지기(시도)의 결과 목록을 표시합니다.*1

Relative Freq: 던지기 결과*2 및 해당 상  도수를 기반으로 발생 횟수를
표시합니다.
*1 주사위가 2개 있는 경우 각 던기기 결과는 각 던지기의 합과 차가 함께
표시됩니다. 세 개의 주사위가 있는 경우 각 던지기의 결과는 던기기의
합과 함께 표시됩니다.

*2 주사위 1개일 경우의 결과(1~6), 주사위 2개일 경우의 결과의 합(2~12)
또는 차(0~5), 주사위 3개일 경우의 결과의 합(3~18).

5. Result Type 메뉴를 사용하여 결과 표시 형식을 선택합니다.
(1) 여기서는 발생 횟수와 상  도수를 표시하고 싶으므로 [Relative Freq]
를 선택하고  키를 누릅니다.

• 그러면 [Sum] 또는 [Difference] 선택 메뉴가 표시됩니다.
(2) 여기서는 각 던기지 결과의 차를 표시하고 싶으므로 [Difference]를 선
택한 다음  키를 누릅니다.

• 시뮬레이션 결과는 Relative Freq 화면에 표시됩니다.

(결과는 각 실행마다 다릅니다.)

• 시뮬레이션 결과 화면에 한 자세한 내용은 “Dice Roll 결과 화
면” (127페이지)을 참조하십시오.

6. 다른 형식을 사용하여 결과를 표시하려면 결과 화면을 표시한 다음 
키를 누릅니다.
• 그러면 Result Type 메뉴로 돌아가므로 이 절차의 5단계를 반복하고 결
과 표시 형식을 변경할 수 있습니다.

7. 다른 설정으로 시뮬레이션을 수행하려면 Result Type 메뉴가 표시된 상
태에서  키를 누릅니다.
• 그러면 시뮬레이션 결과를 지우고 매개변수 입력 화면으로 돌아갑니
다. 3단계부터 절차를 다시 수행하십시오.

8. Dice Roll을 종료하려면 매개변수 입력 화면이 표시된 상태에서  키를
누릅니다.
• 그러면 Math Box 메뉴로 돌아갑니다.
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주의

• Relative Freq 화면에서 Rel Fr 열 셀의 값을 변수에 저장할 수 있습니다. 예를 들어 위의
5단계에서 다음 조작을 수행하면 “Rel Fr” 열의 첫 번째 행에 있는 값이 변수 A에 저장됩
니다:  – [A=] > [Store]. 변수에 한 자세한 내용은 “변수(A, B, C, D, E, F, x, y, z)”
(35페이지)를 참조하십시오.

Dice Roll 결과 화면

• List 화면

(1) 각 행은 일련의 던지기 번호를 보여줍니다. 예를 들어 1은 첫 번째 던
지기이고 2는 두 번째 던지기 등입니다.

(2) A, B, C는 각각 사용 중인 주사위를 나타냅니다. “Sum”은 결과 합계이
고 “Diff”는 두 주사위 결과 간의 차입니다. 디스플레이에 나타나는 열
은 사용 중인 주사위 수에 따라 다릅니다.
1 주사위: A열만 있음.
2 주사위: A, B, Sum, Diff 열.
3 주사위: A, B, C, Sum 열.

• Relative Freq 화면

(1) Sum 또는 Diff: 주사위 1개의 결과(Sum: 1~6), 주사위 2개의 결과 중
합(Sum: 2~12) 또는 차(Diff: 0~5), 또는 주사위 3개의 합의 결과(Sum:
3~18)를 표시합니다.

(2) Freq: 각 던지기 결과의 발생 횟수(도수)를 표시합니다.
(3) Rel Fr: 던지기 결과의 상  도수(도수를 던지기 횟수로 나눈 값)를 표
시합니다.

(4) 시도 횟수
(5) 강조 표시된 Rel Fr 셀 값
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Same Result 설정

초기 설정(Off)에서 Same Result로 Dice Roll 또는 Coin Toss 시뮬레이션을
실행할 때 각 실행은 다른(임의) 결과를 표시합니다. Same Result 설정이
Off가 아닌 다른 것으로 변경되면 표시되는 결과는 계산기에 의해 결정된
결과입니다. #1, #2, #3 설정을 사용하면 수업의 학생들이 사용하는 모든 계
산기에서 동일한 결과를 표시하려는 경우에 유용합니다.

주의

• 여러 계산기에서 동일한 결과를 표시하려면 아래 설정이 모든 계산기에서 동일한지 확
인하십시오.
- 주사위 또는 동전의 수
- 시도 횟수(던지기)
- Same Result 설정(#1, #2, #3)

Coin Toss
Coin Toss는 지정된 횟수만큼 가상 동전을 1개, 2개, 또는 3개 던지는 시뮬
레이션을 수행합니다. 결과에 해 다음 화면 중 하나를 선택할 수 있습니
다.

List 화면

Relative Freq 화면

화면에는 앞면이 로 표시되고 뒷면이 로 표시됩니다.

Coin Toss 일반 조작 절차

예: 동전 3개를 100회 던지기 시뮬레이션. 이 예에서 Relative Freq 화면은
각 던지기의 앞면의 수(0, 1, 2, 3)와 앞면의 상  빈도를 보여주는 시뮬레이
션 결과에 사용됩니다.

1.  키를 누르고 Math Box 앱 아이콘을 선택한 후  키를 누릅니다.
• 그러면 Math Box 메뉴가 표시됩니다.
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2. [Coin Toss]를 선택한 후  키를 누릅니다.
• 그러면 매개변수 입력 화면을 표시합니다.

Coins: 동전의 수를 1, 2, 또는 3으로 선택합니다.
Attempts: 동전 던지기 횟수(시도 횟수)를 1~250의 값으로 입력합니다.
Same Result: 이 설정은 일반적으로 Off(초기 설정)입니다. 자세한 내용
은 “Same Result 설정” (128페이지)을 참조하십시오.

3. 각 메뉴 설정을 선택하고 원하는 방식으로 구성합니다.
(1) [Coins]를 선택한 후  키를 누릅니다. 나타나는 메뉴에서 [3 Coins]
를 선택한 후  키를 누릅니다.

(2) [Attempts]를 선택한 후  키를 누릅니다. 입력 화면이 나타날 때 100
을 입력하고  키를 누릅니다. [Confirm]을 선택한 후  키를 누릅니
다.

(3) [Same Result]를 Off(초기 설정)로 설정한 상태로 둡니다.
4. 모든 설정이 원하는 로 되었으면 [Execute]를 선택하고  키를 누릅니
다.
• 시뮬레이션을 실행한 화면이 나타나며, 그 화면이 Result Type 메뉴로
변경됩니다.

List: 각 던지기(시도)에 해 앞면 또는 뒷면*1 목록을 표시합니다.
Relative Freq: 앞면이 나오는 각 동전의 발생 횟수*2 및 상  도수를 표시
합니다.
*1 동전이 2~3개 있는 경우, 각 던기기에서 앞면이 나오는 동전의 수를 표
시합니다.

*2 동전 2개 또는 3개의 경우. 동전이 하나일 때 앞면과 뒷면의 도수와 상
 도수를 표시합니다.

5. Result Type 메뉴를 사용하여 결과 표시 형식을 선택합니다.
여기서는 발생 횟수와 상  도수를 표시하고 싶으므로 [Relative Freq]를
선택하고  키를 누릅니다.
• 시뮬레이션 결과는 Relative Freq 화면에 표시됩니다.
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(결과는 각 실행마다 다릅니다.)

• 시뮬레이션 결과 화면에 한 자세한 내용은 “Coin Toss 결과 화면”
(130페이지)을 참조하십시오.

6. 다른 형식을 사용하여 결과를 표시하려면 결과 화면을 표시한 다음 
키를 누릅니다.
• 그러면 Result Type 메뉴로 돌아가므로 이 절차의 5단계를 반복하고 결
과 표시 형식을 변경할 수 있습니다.

7. 다른 설정으로 시뮬레이션을 수행하려면 Result Type 메뉴가 표시된 상
태에서  키를 누릅니다.
• 그러면 시뮬레이션 결과를 지우고 매개변수 입력 화면으로 돌아갑니
다. 3단계부터 절차를 다시 수행하십시오.

8. Coin Toss를 종료하려면 매개변수 입력 화면이 표시된 상태에서  키를
누릅니다.
• 그러면 Math Box 메뉴로 돌아갑니다.

주의

• Relative Freq 화면에서 Rel Fr 열 셀의 값을 변수에 저장할 수 있습니다. 예를 들어 위의
5단계에서 다음 조작을 수행하면 “Rel Fr” 열의 첫 번째 행에 있는 값이 변수 A에 저장됩
니다:  – [A=] > [Store].

Coin Toss 결과 화면

• List 화면

(1) 각 행은 일련의 던지기 번호를 보여줍니다. 예를 들어 1은 첫 번째 던
지기이고 2는 두 번째 던지기 등입니다.

(2) A, B, C는 각각 사용 중인 동전을 나타냅니다. 동전이 2개나 3개 사용
될 때 오른쪽  열은 앞면이 나온 동전의 수를 나타냅니다.

• Relative Freq 화면
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(1) Side: 하나의 동전만 사용할 때 “ ”는 앞면을 나타내고 “ ”는 뒷면을
나타냅니다. 2개 또는 3개의 동전을 사용할 때 이 열은 앞면의 수(0~3)
를 나타냅니다.

(2) Freq: 각 던지기 결과의 발생 횟수(도수)를 표시합니다.
(3) Rel Fr: 던지기 결과의 상  도수(도수를 던지기 횟수로 나눈 값)를 표
시합니다.

(4) 시도 횟수
(5) 강조 표시된 Rel Fr 셀 값
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기술 정보

에러

계산 중에 어떤 이유로든 에러가 발생할 때마다 에러 메시지가 계산기에 표
시됩니다.

에러 위치 표시하기
에러 메시지가 표시된 상태에서 , , 또는  키를 누르면 에러 메시지
가 표시되기 직전에 표시되었던 화면으로 돌아갑니다. 에러가 발생한 곳에
커서가 위치해서 입력할 준비가 됩니다. 계산에 필요한 수정을 해서 다시 실
행합니다.

예: 14 ÷ 10 × 2 신에 실수로 14 ÷ 0 × 2를 입력한 경우.

14 0 2

 (또는  또는 )

1

에러 메시지

Syntax ERROR

원인:
• 실행 중인 계산식에 잘못이 있습니다.
책:

• 필요한 수정을 실시합니다.

Math ERROR

원인:
• 실행 중인 계산의 중간 결과 또는 최종 결과가 허용 계산 범위를 넘고
있습니다.

• 입력 데이터가 허용 입력 범위를 넘고 있습니다(특히, 함수를 사용하는
경우).
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• 실행 중인 계산식에 수학적 잘못(예를 들면, 0에 의한 나누기 등)이 있
습니다.

• 복소수를 지원하지 않는 앱을 사용하거나 복소수 입력을 허용하지 않
는 화면이 표시된 상태에서 복소수가 저장된 변수를 포함하는 계산을
실행하려고 했습니다.
책:

• 입력값을 확인해서 자릿수를 줄이고 재실행합니다.
• 함수의 인수로서 변수를 사용하고 있는 경우에는 변수 값이 함수의 허
용 범위 내에 있는지 확인하십시오.

• 복소수가 저장되어 있는 변수가 포함된 계산을 수행하려면 복소수를
지원하지 않는 앱을 사용하거나 복소수 입력을 허용하지 않는 화면이
표시된 상태에서 변수에 저장된 값을 실수로 변경합니다.

Stack ERROR

원인:
• 실행중인 계산에서 수치 스택 또는 명령 스택의 용량을 넘었습니다.
• 실행하고 있는 계산이 행렬 또는 벡터 스택의 용량을 초과했습니다.
책:

• 스택의 용량을 넘지 않게 계산식을 간단하게 합니다.
• 계산을 2개 이상의 부분으로 나누어 실행합니다.

Argument ERROR

원인:
• 실행하고 있는 계산의 인수에 문제가 있습니다.
책:

• 필요한 수정을 실시합니다.

Dimension ERROR (Matrix 및 Vector 앱만 해당)

원인:
• 그런 종류의 계산을 허용하지 않는 차원의 행렬 또는 벡터로 계산을 실
행하려 하고 있습니다.
책:

• 행렬 또는 벡터에 지정된 차원을 확인해서 계산과 호환하는지 확인합
니다.
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Variable ERROR (Equation 앱의 Solver 기능만 해당)

원인:
• 변수가 포함되지 않은 표현식 입력에 해 Solver를 실행하려는 시도입
니다.
책:

• 변수가 포함된 표현식을 입력합니다.

Cannot Solve (Equation 앱의 Solver 기능만 해당)

원인:
• 계산기가 해를 구할 수 없었습니다.
책:

• 입력한 방정식 내의 에러를 확인합니다.
• 예상되는 해에 가까운 해의 변수에 한 값을 입력한 후 다시 시도합니
다.

Range ERROR

원인(Table 앱):
• 조건이 허용되는 최  행 수를 초과하는 Table 앱에서 수치표를 생성하
려는 시도입니다.
책:

• Start 값, End 값, Step 값을 바꾸어서 표 계산 범위를 좁혀 다시 시도합
니다.
원인(Spreadsheet 앱):
• Spreadsheet 앱에서 일괄 입력 시 Range에 한 입력이 허용 범위를
벗어나거나 존재하지 않는 셀 이름입니다.
책:

• Range의 경우 다음 구문을 사용하여 A1~E45 범위 내의 셀 이름을 입
력합니다: “A1:A1”.
원인(Math Box 앱):
• Dice Roll 또는 Coin Toss에 한 Attempts(시도 횟수)로 입력한 값이
허용 범위를 벗어나거나 정수가 아닌 값입니다.
책:

• Attempts의 경우 허용 범위 내에서 정수 값을 입력합니다.

Time Out

원인(미분 또는 적분 계산):
• 현재의 미분 또는 적분 계산이 종료 조건이 충족되지 않은 상태에서 종
료되었습니다.
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책:
• tol 값을 크게 합니다. 이것에 의해서 해의 정밀도가 감소하므로 주의합
니다.
원인(Distribution 앱):
• 현재의 분포 계산이 종료 조건이 충족되지 않은 상태에서 종료되었습
니다.
책:

• 각 매개변수의 값을 변경합니다.

Circular ERROR

원인(f(x) 및 g(x) 기능):
• 등록된 합성 함수에서 순환 참조가 발생하고 있습니다(“합성 함수 등록
하기” (61페이지)).
책:

• f(x)에 g(x) 입력 및 g(x)에 f(x) 입력을 동시에 하지 마십시오.
원인(Spreadsheet 앱):
• 스프레드시트에 순환 참조(예: 셀 A1의 “=A1”)가 있습니다.
책:

• 순환 참조를 제거하려면 셀 내용을 변경하십시오.

Memory ERROR (Spreadsheet 앱만 해당)　

원인:
• 허용 가능한 입력 용량(1,700바이트)을 초과하는 데이터를 입력하려고
합니다.

• 계속하여 연속적인 셀 참조(예: A1셀에서 참조된 A2셀, A2셀에서 참조
된 A3셀 등)를 생성하는 데이터를 입력하려고 하고 있습니다. 이러한
종류의 입력은 메모리 용량(1,700바이트)을 초과하지 않더라도 항상
이 에러를 발생시킵니다.
책:

• 불필요한 데이터를 삭제하고 다시 데이터를 입력하십시오.
• 계속하여 연속적인 셀 참조 체인을 생성하는 입력을 최소화합니다.

Not Defined

원인(f(x) 및 g(x) 기능):
• f(x)/g(x)가 정의되지 않은 상태에서 f(x) 또는 g(x)를 계산하려고 했습니
다.
책:

• f(x)/g(x)를 계산하기 전에 f(x) 또는 g(x)를 정의하십시오.
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원인(Matrix 및 Vector 앱):
• 계산에서 사용하려고 하는 행렬 또는 벡터의 차원을 지정하지 않고 입
력했다.
책:

• 행렬 또는 벡터의 차원을 지정한 후 계산을 다시 실행한다.

계산기의 고장이라고 생각하기 전에...
이들 단계를 실행하기 전에는 중요한 데이터를 별도로 복사해야만 하는 것
에 유의해 주십시오.
1. 계산식을 확인해서 에러를 포함하고 있지 않은지 확인해 주십시오.
2. 실행하고자 하는 계산 종류에 해서 올바른 계산기 앱을 사용하고 있는
지 확인해 주십시오.
• 현재 사용 중인 계산기 앱을 확인하려면  키를 누르십시오. 이것은
현재 사용 중인 계산기 앱의 아이콘을 강조 표시합니다.

3. 위의 단계로 문제를 해결할 수 없으면  키를 누르십시오.
• 이것은 계산기에서 계산 기능이 올바르게 작동하고 있는지를 확인하는
일련의 절차를 실행합니다. 계산기에 이상이 발견되면, 자동으로 계산
기 앱을 초기화하고 메모리 내용을 삭제합니다.

4. 아래 절차를 수행하여 계산기 설정(Contrast 및 Auto Power Off 제외)을
초기 설정으로 되돌립니다.
(1)  키를 누르고 계산기 앱 아이콘을 선택한 후  키를 누릅니다.
(2)  키를 누른 다음 [Reset] > [Settings & Data] > [Yes]를 선택합니다.

전지 교체
전원을 켠 직후 아래와 같은 화면이 나타나면 전지 잔량이 부족한 것입니다.

콘트라스트를 조정해도 표시가 흐릿한 경우, 계산기의 전원을 켠 직후에 표
시부가 점등되지 않은 경우에도 전지가 소모된 것입니다.
이런 경우 또는 상기 화면이 표시되는 경우에는 새 것으로 전지를 교체해 주
십시오.

중요!

• 전지를 교체하면 계산기의 모든 메모리 내용이 삭제됩니다.

1. (OFF) 키를 눌러서 계산기의 전원을 끕니다.
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• 전원 교체 시에 우발적으로 전원을 켜지 않도록 하기 위해서 계산기 전
면에 전면 커버를 부착합니다.

2. 그림과 같이 전지 커버를 제거하고 전지를 제거한 다음 플러스(+) 및 마
이너스(-)가 올바르게 향하도록 새 전지를 장착하십시오.

3. 전지 커버를 다시 끼웁니다.
4.  키를 눌러서 계산기의 전원을 켭니다.
5. 계산기를 초기화합니다.

(1)  키를 누르고 계산기 앱 아이콘을 선택한 후  키를 누릅니다.
(2)  키를 누른 다음 [Reset] > [Initialize All] > [Yes]를 선택합니다.
• 위의 단계를 생략하지 마십시오!

계산 우선 순위
계산기는 계산 우선 순위에 따라 계산을 수행합니다.

• 기본적으로 계산은 왼쪽에서 오른쪽으로 수행됩니다.
• 괄호 안의 표현식이 가장 높은 우선 순위를 갖습니다.
• 다음은 각 개별 명령의 우선 순위를 보여줍니다.

1 괄호식

2
괄호가 있는 함수(sin(, log(, f(, g( 등, 인수를 오른쪽으로 받는
함수, 인수 뒤에 닫는 괄호가 필요한 함수)

3
입력 값 뒤에 오는 함수(x2, x3, x-1, x!, °’ ”, °, r, g, %, t), 공학
기호(m, μ, n, p, f, k, M, G, T, P, E), 누승( ), 누승근( )

4 분수
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5 마이너스 기호((-)), Base Prefix (d, h, b, o)

6 단위 변환 명령(cm in 등), Statistics 앱 추정값(x̂, ŷ, x̂1, x̂2)

7 승산 기호가 삭제된 곳의 승산

8 순열(nPr), 조합(nCr), 복소수 극좌표 기호(∠)

9 내적(•)

10 승산(×), 제산(÷)

11 가산(+), 감산(−)

12 and(논리 연산자)

13 or, xor, xnor(논리 연산자)

계산에 음의 값가 포함된 경우 음의 값을 괄호로 묶어야 할 수 있습니다. 예
를 들어 값 -2를 제곱하려면 다음을 입력해야 합니다: (-2)2. x2는 값(위의 우
선순위 3)이 선행하는 함수이며, 그 우선순위가 접두사 기호(우선순위 5)인
마이너스 기호보다 높기 때문입니다.

예:
((-))2     -22 = -4

((-))2  (-2)2 = 4

계산 범위, 자리수 및 정밀도
계산 범위, 내부 계산에 사용되는 자릿수 및 계산 정밀도는 실행하는 계산의
종류에 따라 달라집니다.

계산 범위 및 정밀도

계산 범위 ±1 × 10-99 ~ ±9.999999999 × 1099 또는 0

내부 계산용 자릿수 23자리

정밀도

일반적으로 단일 계산에 해서 10번째 자
릿수에서 ±1입니다. 지수 표시에 한 정
밀도는 최하위의 수에서 ±1입니다. 연속
계산인 경우에는 에러가 누적됩니다.
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함수 계산 입력 범위 및 정밀도

함수 입력 범위

sinx
cosx

Degree 0 ≤ |x| < 9 × 109

Radian 0 ≤ |x| < 157079632.7

Gradian 0 ≤ |x| < 1 × 1010

tanx

Degree
|x| = (2n - 1) × 90인 경우를
제외하고는 sinx와 같은 범
위.

Radian
|x| = (2n - 1) × π/2인 경우를
제외하고는 sinx와 같은 범
위.

Gradian
|x| = (2n - 1) × 100인 경우를
제외하고는 sinx와 같은 범
위.

sin-1x, cos-1x 0 ≤ |x| ≤ 1

tan-1x 0 ≤ |x| ≤ 9.999999999 × 1099

sinhx, coshx 0 ≤ |x| ≤ 230.2585092

sinh-1x 0 ≤ |x| ≤ 4.999999999 × 1099

cosh-1x 1 ≤ x ≤ 4.999999999 × 1099

tanhx 0 ≤ |x| ≤ 9.999999999 × 1099

tanh-1x 0 ≤ |x| ≤ 9.999999999 × 10-1

logx, lnx 0 < x ≤ 9.999999999 × 1099

10x -9.999999999 × 1099 ≤ x ≤ 99.99999999

√x 0 ≤ x < 1 × 10100

x2 |x| < 1 × 1050

x-1 |x| < 1 × 10100; x ≠ 0
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x! 0 ≤ x ≤ 69 (x는 정수)

nPr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r은 정수)
1 ≤ {n!/(n - r)!} < 1 × 10100

nCr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r은 정수)
1 ≤ n!/r! < 1 × 10100 또는 1 ≤ n!/(n - r)! < 1 × 10100

Pol(x, y)
|x|, |y| ≤ 9.999999999 × 1099

√x2 + y2 ≤ 9.999999999 × 1099

Rec(r, θ)
0 ≤ r ≤ 9.999999999 × 1099

θ: sinx와 동일

a°b’c”
|a|, b, c < 1 × 10100; 0 ≤ b, c
표시되는 초의 값은 소수 2째 자리에서 ±1의 에러
를 가집니다.

a°b’c” = x
0°0’0” ≤ |x| ≤ 9999999°59’59”
위 범위를 벗어난 60진수 값은 자동으로 10진수
값으로 처리됩니다.

xy

x > 0: -1 × 10100 < ylogx < 100
x = 0: y > 0

x < 0: y = n, m
2n + 1 (m, n은 정수)

단, -1 × 10100 < ylog |x| < 100

x
√y

y > 0: x ≠ 0, -1 × 10100 < 1/x logy < 100
y = 0: x > 0

y < 0: x = 2n+1, 2n + 1
　 m　

 (m ≠ 0; m, n은 정수)

단, -1 × 10100 < 1/x log |y| < 100

a b/c
정수, 분자 및 분모의 합계가 10자릿수 이내(구분
기호 포함).

RanInt#(a, b) a < b; |a|, |b| < 1 × 1010; b - a < 1 × 1010

• 정밀도는 위의 “계산 범위 및 정밀도”에서 설명된 것과 기본적으로 같습
니다.

• xy, 
x
√y, x!, nPr, nCr 타입의 함수는 연속적인 내부 계산을 필요로 해서 각

계산에서 발생하는 에러가 축적될 수 있습니다.
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• 에러는 축적되며 함수의 단일점 및 변곡점 근처에서 커지는 경향이 있습
니다.

• SETTINGS 메뉴의 Input/Output에 MathI/MathO를 선택했을 때 π 형태로
표시될 수 있는 계산 결과의 범위는 |x| < 106입니다. 그렇지만, 내부 계산
에러로 인해서 일부 계산 결과를 π 표시로 나타낼 수 없는 경우가 있다는
것에 유의해 주십시오. 이것은 또한 소수점 표시이어야 할 계산 결과를 π
표시로 되게 할 수도 있습니다.

사양

fx-570CW
전원:
AAA 사이즈 전지 R03 × 1

략적인 전지 수명:
2년(1일 1시간의 사용 조건)

전력 소모:
0.0008W

작동 온도:
0°C ~ 40°C

치수:
13.8 (높이) × 77 (폭) × 162 (깊이) mm

략적인 중량:
전지 포함 100g

fx-991CW
전원:
내장 태양 전지; 버튼 전지 LR44 × 1

략적인 전지 수명:
2년(1일 1시간의 사용 조건)

작동 온도:
0°C ~ 40°C

치수:
10.7 (높이) × 77 (폭) × 162 (깊이) mm

략적인 중량:
전지 포함 95g
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자주 묻는 질문

자주 묻는 질문
■ 제산 조작으로 생성된 분수 표시 결과를 소수점 표시로 변경하려면 어떻
게 해야 합니까?

→ 분수 계산 결과가 표시된 상태에서  키를 누른 후 [Decimal]을 선택하
거나 ( ) 키를 누릅니다. 계산 결과가 처음에 소수 값으로 나타나
게 하려면 SETTINGS 메뉴의 Input/Output 설정을 MathI/DecimalO로 변
경하십시오.

■ Ans 메모리 및 변수 메모리 간의 차이는 무엇입니까?
→ 이들 종류의 각 메모리는 단일값의 임시 보관을 위한 “용기”와 같은 작용
을 합니다.
Ans 메모리: 실행한 마지막 계산 결과를 저장합니다. 이 메모리를 사용해
서 하나의 계산 결과를 다음에 실행합니다.
변수 메모리: 이 메모리는 하나 이상의 계산에서 동일한 값을 여러 번 사
용할 필요가 있을 때에 도움을 줍니다.

■ 이 계산기에서 이전 CASIO 계산기 모델에서 사용하던 함수를 어떻게 찾
을 수 있습니까?

→ 이 계산기의 함수는  키를 눌렀을 때 나타나는 CATALOG 메뉴에서 액
세스할 수 있습니다. 자세한 내용은 아래 절을 참조하십시오.
“CATALOG 메뉴 사용하기” (24페이지)
“고급 계산” (45페이지)

■ 구형 CASIO 계산기 모델에서는  키를 눌러 계산 결과 표시 형식을 변
경했습니다. 이 계산기로 무엇을 해야 합니까?

→ 계산 결과가 표시된 상태에서  키를 누릅니다. 표시되는 메뉴를 사용
하여 원하는 표시 형식을 선택하십시오. 자세한 내용은 “계산 결과 형식
변경하기” (38페이지)를 참조하십시오.

■ 현재 어떤 계산기 앱을 사용하고 있는지 어떻게 알 수 있습니까?
→  키를 누릅니다. 그러면 현재 사용 중인 계산기 앱의 아이콘이 강조 표
시됩니다.

■ sin2 x 계산 방법

→ 예를 들어 sin2 30 =  1
4
를 계산하려면 아래 계산을 입력합니다.

30
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■ 왜 (i) 입력 또는 복소수 계산을 할 수 없습니까?
→ Calculate 앱을 사용하여 i를 입력하거나 복소수 계산을 수행할 수 없습
니다. 이러한 계산에는 Complex 앱을 사용하십시오.

■ 계산기를 켠 직후에 전지 아이콘( )이 나타나는 이유는 무엇입니까?
→ 전지 아이콘은 전지 전원이 부족함을 나타냅니다. 이 아이콘이 보이면 가
능한 한 빨리 전지를 교체하십시오. 전지 교체에 한 자세한 내용은 “전
지 교체” (136페이지)를 참조하십시오.

■ 계산기를 초기 설정으로 되돌리려면 어떻게 해야 합니까?
→ 아래 절차를 수행하여 계산기 설정을 초기화하십시오(Contrast 및 Auto

Power Off 제외).
(1)  키를 누르고 계산기 앱 아이콘을 선택한 후  키를 누릅니다.
(2)  키를 누른 다음 [Reset] > [Settings & Data] > [Yes]를 선택합니다.

143



© 2022 CASIO COMPUTER CO., LTD.
SA2207-A


	목차
	계산기 사용 전에
	먼저 읽으십시오
	본 사용설명서에 대하여
	키 조작
	메뉴 조작
	[OK] 키 및 [EXE] 키
	예

	계산기 초기화하기
	계산기 “Get Started” 화면
	주의 사항
	안전상의 주의사항
	취급상 주의사항

	시작하기
	전면 커버 부착 및 제거
	전원 켜기 및 끄기
	HOME 화면
	표시 콘트라스트 조정하기
	키 표시
	인디케이터
	메뉴 사용하기


	계산기 앱 및 메뉴
	계산기 앱
	계산기 앱 선택
	설치된 계산기 앱 목록

	SETTINGS 메뉴 사용하기
	계산기 설정 변경하기
	항목 및 사용 가능한 설정 옵션

	CATALOG 메뉴 사용하기
	TOOLS 메뉴 사용하기

	식 및 값 입력하기
	기본 입력 규칙
	자연수 텍스트북 형식을 사용하여 표현식 입력하기(MathI/MathO 또는 MathI/DecimalO만 해당)
	조작 취소
	값과 표현식을 인수로 사용하기

	덮어쓰기 입력 모드(LineI/LineO 또는 LineI/DecimalO만 해당)

	표준 계산
	산술 계산
	분수 계산
	누승, 누승근, 역함수
	파이, 자연로그의 밑 e
	파이
	자연로그의 밑 e

	계산 이력 및 재생
	계산 이력
	재생

	메모리 함수 사용하기
	앤서 메모리(Ans)
	변수(A, B, C, D, E, F, x, y, z)
	모든 메모리의 내용 삭제하기


	계산 결과 형식 변경하기
	FORMAT 메뉴 사용하기
	FORMAT 메뉴 목록
	변환 샘플 조작

	Standard 및 Decimal 변환
	소인수 분해
	직교좌표 및 극좌표 변환
	가분수 및 대분수 변환
	공학 표기
	60진수 변환(도, 분, 초 계산)
	10진수 값 계산 결과를 60진수 값으로 변환하기
	60진수 값 입력 및 계산하기


	고급 계산
	함수 분석
	Derivative(d/dx)
	Integration(∫)
	Summation(Σ)
	Logarithm(logab), Logarithm(log)
	Natural Logarithm

	확률
	%
	Factorial(!)
	Permutation(P), Combination(C)
	Random Number
	Random Integer

	수치 계산
	Absolute Value
	Round Off

	각도 단위, 극좌표/직교좌표, 60진수
	Degrees, Radians, Gradians
	Rect to Polar, Polar to Rect
	도, 분, 초

	쌍곡선, 삼각
	쌍곡선 함수
	삼각 함수

	공학 기호
	과학 상수
	단위 변환
	기타

	f(x) 및 g(x)에 대한 정의 방정식 등록 및 사용하기
	f(x) 및 g(x)에 대한 정의 방정식 등록 및 사용하기
	정의 방정식 등록하기
	등록된 정의 방정식에 값을 할당하여 계산 수행하기
	합성 함수 등록하기
	데이터 보존


	QR Code 기능 사용하기
	QR Code 기능 사용하기
	QR Code 표시하기
	QR Code를 스캔하는 데 문제가 있는 경우


	계산기 앱 사용하기
	통계 계산
	통계 계산을 수행하기 위한 일반 절차
	통계 편집기에 데이터 입력하기
	통계 계산 결과 표시
	통계 계산 화면 사용
	통계 계산식

	분포 계산
	분포 계산을 수행하기 위한 일반 절차
	매개변수 목록
	목록 화면
	목록 화면 내용 편집하기
	계산 예

	스프레드시트 사용하기
	셀 내용 입력 및 편집
	셀에 상수와 수식 입력하기
	셀 상대 참조 및 절대 참조
	Spreadsheet 앱 특수 명령 사용하기
	동일한 수식이나 상수를 여러 셀에 일괄 입력하기
	Spreadsheet 앱 설정 항목
	Auto Calc 및 Recalculate

	수치표 생성하기
	수치표 생성을 위한 일반 절차
	Table Type에 따른 수치표의 최대 행 수
	정의 방정식 등록
	수치표 화면 데이터 편집하기
	f(x) 및 g(x) 업데이트 타이밍
	데이터 보존

	방정식 계산
	연립 1차방정식
	2차~4차의 고차 방정식
	Solver 사용하기

	부등식 계산
	부등식 계산을 수행하기 위한 일반 절차

	복소수 계산
	복소수 입력하기
	Complex 앱 계산 예

	n진 계산
	특수한 입력값의 번호 모드 지정하기
	다른 종류의 값으로 계산 결과 변환하기
	논리 및 부정 조작

	행렬 계산
	행렬 계산을 수행하기 위한 일반 절차
	행렬 변수 목록 화면
	행렬 응답 메모리(MatAns)
	행렬 계산 예

	벡터 계산
	벡터 계산을 수행하기 위한 일반 절차
	벡터 변수 목록 화면
	벡터 응답 메모리(VctAns)
	백터 계산 예

	비율 계산
	비율 계산을 수행하기 위한 일반 절차
	계산 예

	Math Box 사용하기
	Dice Roll
	Coin Toss


	기술 정보
	에러
	에러 위치 표시하기
	에러 메시지

	계산기의 고장이라고 생각하기 전에...
	전지 교체
	계산 우선 순위
	계산 범위, 자리수 및 정밀도
	계산 범위 및 정밀도
	함수 계산 입력 범위 및 정밀도

	사양

	자주 묻는 질문
	자주 묻는 질문


